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1. Introduction

This protocol was written for researchers, research assistants and students who are planning to run
EEG experiments with infants in the UiL OTS Babylab. It is an extensive document which includes
both the general protocol for testing, as well as a comprehensive step-by-step guide to analysing
your EEG data.

NOTE: The step-by-step analysis does not apply for all experiments! Researchers must adapt and
modify the analysis when needed. This protocol does not focus on how to design an EEG experiment.

Throughout the entire protocol, we use an oddball paradigm experiment as an example. The aim of
this research project was to investigate whether 4-month-olds and 12-month-olds could discriminate
between differences in pitch in different modalities. The two modalities that were investigated were
music and lexical tones (in Standard Mandarin Chinese). Also, the ability to discriminate between
different native vowels was investigated. For this, we looked at the ‘Mismatch Negativity’ component
(referred to as ‘MMN’ in this document), which exhibits as an amplitude difference between the ERP
to a deviant stimulus (the ‘oddball’) and the ERP to a standard stimulus. Therefore, this analysis
overview is most suitable for researchers who want to compare ERPs following different types of
stimuli. Please note that different research questions may need a different approach to the analysis.

A reference is made to ready-to-use MATLAB scripts several times throughout the analysis section. If

you wish to use one of these scripts, please contact Ao Chen (a.chen@uu.nl). Note that you still need
to adapt these scripts to make them fit for your own experiment and stimuli.

Should you have any questions or suggestions, please contact us by sending an email to:

Ao Chen A.Chen@uu.nl
Lisanne Geurts L.J.D.Geurts-5@umcutrecht.nl
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2. A preliminary remark on how to treat electrodes with care

Before you start your first testing day, make sure you have read and understood this
section carefully. Should you have any questions, please do not hesitate to ask!

Electrodes are very fragile and an entire electrode bundle may become completely useless
once only one of the electrodes dies. The lifespan of electrodes can be shortened
drastically when handled without care. Therefore, it is important to keep a few things in
mind when working with electrodes.

- NEVER let the electrodes touch metal. Always remove all of your jewellery before
preparing the cap and cleaning the electrodes. Also, make sure your participant isn't
wearing any metal hairclips.

- When preparing the cap, let the bundles hang around your neck to prevent the ends
from touching the floor.

- When cleaning the electrodes, make sure that the water is lukewarm. The gel will
dissolve more easily when the water isn’t too cold, but too hot water will cause the
electrodes to break faster.

- Never let the electrodes lay in the water for too long; when you put them into the
water, clean and (gently) dry them immediately.

- NEVER let the other end of the bundle (which connects to the amplifier) touch water.

- NEVER let the electrodes sit under running water.

- Always clean the electrodes as soon as possible, before the gel gets the chance to dry.

- Besure that no gel is left behind on the electrodes.

- Always clean the electrodes gently, using a soft brush. Don’t push or rub too hard.
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3. The standard testing procedure

This section offers you a detailed description of how to run an EEG experiment with infants. In the

lab, we make use of BioSemi equipment, and all experiments should be written in Presentation.

Before you can start testing, make sure you have:

- Approval of the ethics committee

- Designed your experiment. NOTE: Make sure that all triggers are sent at the precisely right time
from Presentation to Actiview!

- Scheduled your participants

- Reserved the EEG lab. There are two EEG labs at Janskerkhof 13: room K.13 and room K.02.

Note that a brief checklist of the entire procedure can be found here.

3.1 The Babylab waiting area

At the beginning of your testing day, make sure you open up the waiting area (room K.01) and turn
on the light. Check if there is still water in the watering can, the kettle and the Nespresso machine,
and if the plant needs watering. Also make sure that the room looks clean and tidy. You can open the
waiting area and the EEG lab with the same key.

General instructions for correct use of the waiting area can be found here. NOTE: this document is
password protected, please contact Desiree Capel for the login details.

3.2 The control room
The control room is where the test leader will be during the experiment.

3.2.1 Theset-up (K.13)

IMAGE 3.1


mailto:d.j.h.capel@uu.nl
http://www.hum.uu.nl/uilots/lab/resources/protected/Babylab/Waiting_area.pdf
https://fris.hum.uu.nl/
http://uilots-labs.wp.hum.uu.nl/resource/handleiding-babylab-online-belsysteem-bellercaller-dutch/
http://uilots-labs.wp.hum.uu.nl/how-to/experiment-eeg-intro/
http://etcl.wp.hum.uu.nl/
http://uilots-labs.wp.hum.uu.nl/how-to/running-an-eeg-experiment-implement/
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The control room in K.13 contains the following equipment:

Two computers (‘EEG1’ for recording and ‘EEG2’ for presenting; circled in in IMAGE 3.1).
You can find labelled stickers indicating which is which on the computers and screens.

Two screens for the left computer (numbered ‘1’ and ‘2’ in IMAGE 3.1)

Two screens for the right computer (numbered ‘3’ and ‘4’ in IMAGE 3.1)

One webcam monitor (numbered ‘5’ in IMAGE 3.1)

One Tangent amplifier (circled in green in IMAGE 3.1)

One audio switch box (circled in blue in iMaGe 3.1; enlarged in IMAGE 3.3)

One video switch box (circled in red in iMaGe 3.1; enlarged in IMAGE 3.3)

Two remote controls (IMAGE 3.2)

3.2.1.1 Preparation

Turn on both computers and all screens.

IMAGE 3.2

Turn on the webcam monitor (‘5’ in IMAGE 3 .1) by pressing the power button on the Philips
remote control (circled in purple in iMaGe 3.2, the power button is circled in blue).

Use the remote control circled in in IMAGE 3.2 to turn on the camera in the test room. Set
it to the right position by using the arrow buttons circled in red. Watch the webcam monitor
from the door while adjusting the webcam position to immediately check whether the position is
right.

Turn on the Tangent amplifier by pressing the power button on the left hand side.

IMAGE 3.3
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- Set the audio switch box to ‘T’ (Tangent amplifier; circled in green in iMaGe 3.3).

- Set the video switch box to the correct screen by clicking either one of the two buttons circled in
purple iniMace 3.3. The left button is to select screen number 1 (in IMAGe 3.1), the right button
is to select screen number 3 (IMAGE 3.1). The green light, circled in in IMAGE 3.3, indicates
which screen is selected. The selected screen will be on the screen in the test room, and will be
visible for the participant.

e [f the child needs to watch a DVD during the experiment, insert the DVD into the computer
on the left hand side. Select screen number 1 using the video switch.

e If the experiment contains visual stimuli in Presentation, select screen number 3. If the child
needs to watch a DVD with sound, also select screen number 3 and insert the DVD into the
computer on the right hand side.

3.2.2 The set-up (K.02)

S |

A

e

IMAGE 3.4

The control room in K.02 contains the following equipment:

- Two computers (one for presenting the stimuli, circled in red in iMaGe 3 .4, and one for recording,
circled in green in IMAGE 3 .4). You can find labelled stickers indicating which is which on the
computers and screens.

- Headphones for masking the researcher (circled in in IMAGE 3 .4).

- A microphone for talking to the parent in the test room (circled in blue in IMAGE 3 .4).

- Akitchen block, containing electrode bundles, electrode gel, caps and other EEG materials, and
material for cleaning all equipment.

3.2.2.1 Preparation

- Turn on both computers. Make sure they start up in the right mode (when using Zep, start
Kubuntu/when using Presentation, start Windows).

- Onthe Recording PC: start the program OBS Studio. Check the position of the webcam.

- If the child needs to watch a DVD at some part during the experiment: insert it into the
Presentation PC. Open the DVD in VLC Media Player and drag it to the correct screen in the test
room.
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3.3 The test room
The test room is where the participant will be during the entire experiment.

3.3.1 Theset-up (K.13)

The test room in K.13 (IMAGE 3.5) contains the following equipment:

- Ahigh chair for children

- Achair for adults

- Atable, covered with soft material to mute the sound of toys that are smashed onto the table

- One monitor for the presentation of visual stimuli

- Two speakers for the presentation of auditory stimuli

- Awebcam (circled in blue in IMAGE 3.5)

- Aplastic cabinet (circled in green in IMAGE 3.5), containing the BioSemi amplifier, head caps,
electrode stickers, cotton pads and alcohol

- Akitchen block, containing material for cleaning all equipment, electrode bundles (circled in red
in IMAGE 3.5), electrode gel and spare materials.

- An air humidifier (circled in in IMAGE 3.5, enlarged in IMAGE 3.10)

- Adecibel meter (next to the arrow in IMAGE 3.5, enlarged in IMAGE 3.8)

A

l-a_

-

7 _,‘i‘ :
) £

IMAGE 3.5

3.3.2 The set-up (K.02)

The test room in K.02 (image 3 .6) contains the following equipment:
- Ahigh chair for children

- Achair for adults

- Atable

- Three monitors for the presentation of visual stimuli

- Two speakers for the presentation of auditory stimuli

- Awebcam (circled in red in image 3.6)

- A pair of headphones for masking the parent (circled in green in image 3.6)
- The BioSemi amplifier (circled in blue in image 3 .6)

- Aventilator (indicated with the arrow in image 3.6)

10
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IMAGE 3.6

3.3.3 General preparation

From the plastic cabinet next to the table (K.13) or the kitchen block in the control room (K.02), get
out the following items:

- Electrode stickers (‘1’ in IMAGE 3.7)

- Cotton pads (‘2')

- Alcohol (‘3’)

- Electrode gel (‘4")

- Asyringe (‘5)

Place all items on top of the cabinet/table in the test room.

IMAGE 3.7

11
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Next, consider whether you want the child to sit in the baby chair, or whether you want it to be on
the parent’s lap, for instance if it's too young to sit down independently. Place the chairs according to
your decision. Make sure that the child is seated right in front of the screen, in the middle of the two
speakers. When testing in K.02, turn on the two speakers and the display(s) that you’re going to use
by pushing the on/off-buttons. Keep the other displays turned off. When testing in K.13, check if the
table is covered with the towel.

Once everything is prepared, start the experiment on the Presentation (K.02) or EEG2 (K.13)
computer and check the sound level. There is a decibel meter on the shelf in the test room in K.13.
Hold the tip of the decibel meter (circled in in IMAGE 3.8) at the place where the child’s ear will
be during the experiment, and turn on the device using the switch circled in red in iMace 3.8. You will
see a number starting around 110 on the screen of the device, which will drop slowly until it keeps on
circling around a certain number. This is the current sound level. The desirable sound level is
approximately 65 decibel. If it is too high or too low, change the sound level in your experiment. For
more information on how to use the decibel meter, please visit the UiL OTS labs website.

IMAGE 3.8

3.3.3.1 Changing the sound level in Presentation

If, after checking the sound level with the decibel meter, you find that the sound level is too high or
too low, there are two ways to change the volume when using Presentation. Depending on your
settings in Presentation, you could do it in either one the following manners.

One way to change the sound level, is to change the volume of the Presentation/EEG2 computer in
the lower right corner of your screen (as you usually change the volume). This will work, as long as
you haven't installed a fixed sound level in your Presentation experiment. If you notice that the
volume automatically jumps back to the original sound level after restarting the experiment, you
need to adjust the volume in Presentation itself.

12
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To do this, open up your experiment and go to the tab ‘Settings’ (circled in green in IMAGE 3.9). On the
left hand side, go to ‘Audio’. You will see the audio settings appear. Underneath ‘Volume’, you will
probably see that the checkbox in front of ‘Set Device and Application Volume Device Volume' is
checked (circled in blue in IMAGE 3.9). Adjust the sound level by typing in a higher or lower number
between 0.0 and 1.0 in the square circled in red and click ‘Apply now’. Restart the experiment and
check the sound level again. You should now see that the volume has changed.

Ioixd
Experiment Editor Tools License  Help
Main | Scenarios | Parameters] Settings [Edtor |
[~ Sound Device
el Sound Card: | Frimary Sound Diiver | Test
Sound Format: [166t = [steea x| Frequency: [44100 Properties

% Mier

Respanse
" DirectX Software 14" Presentation Mixer

& Eluavemode

> e

o Shared mode

Pudic

Valume
[\? Device and Appiication Volume Device Volume (0.0 - 1.04 [1.42 Apply Now
Port
I™ Set Giobal Atenuation (0.0-1.0): [1 Open Windows Volume

Logfles Advanced Settings

A7 Sound Capture Settings

il E—

FTP
Advanced

IMAGE 3.9

3.3.4 Air circulation

3.3.4.1 RoomK.13

When testing in K.13, you'll find an air humidifier next to the kitchen block (iMaGe 3.10). This device
secures a pleasant air humidity inside the test room, to make sure that participants don’t blink their
eyes too much.

Before you start testing, remove the entire grey part from the white part by lifting it up. Fill up the
white box with water until the water level reaches ‘max’ (you can check the water level by looking at
the indicator circled in red in IMAGE 3.10). Put the grey part back on again, plug the humidifier in and
press ‘power’ (circled in green).

IMAGE 3.10

13
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3.3.4.2 Room K.02

Before testing in K.02, make sure you refresh the air with help of the ventilator. Underneath the
table, you will find a small ventilator attached to the wall (image 3.11). Press the on-button (circled
inred inimage 3.11) to start the air flow. Turn it off when your experiment starts to reduce the
noise.

IMAGE 3.11

3.4 Receiving the participant and preparing the cap

After you have prepared the control and test room, it is time to receive the parent and the baby in
the waiting area. In the waiting area, shortly explain what is going to happen and let them sign the
informed consent form. Take them to the EEG lab. Once they are seated, you can start the
preparation of the cap.

3.4.1 Apply gel on the baby’s wrist

Before doing anything at all, apply a little bit of gel on the baby’s wrist using the syringe. Tell the
parent that you’re doing this to make sure there won't be an allergic reaction to the gel. You can
show them that the syringe won't hurt the child, by tapping the tip of the syringe onto your own
palm. Tell the parent that the chances of getting an allergic reaction are extremely small, due to the
fact that the gel is basically only a combination of water and salt.

3.4.2 Explain the procedure

While giving the baby’s skin a chance to react to the gel, explain the procedure to the parent.

Mention the following things:

- What the experiment is about

- A brief explanation of the EEG procedure

- The duration of the actual experiment

- What the child is and isn’t allowed to do (e.g. play with the toys)

- Tell the parent not to speak during the experiment

- Also tell the parent to try to prevent the baby from pulling the cap or the electrodes as good as
they can.

- Ask the parent to switch their phone to airplane mode, otherwise its signals will interfere with
the EEG.

- Let them know that they are being watched through the webcam, and whether there will be a
video recording of the experiment.

14
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- If they want to stop the experiment, for whatever reason, they can wave to the camera.

- If the baby becomes too restless, you can stop at any time.

- They can wash their baby’s head at the end of the experiment.

After the explanation, check the baby’s wrist once more. If the skin hasn't reacted to the gel, proceed
with the preparation. If there seems to be an allergic reaction, quit the experiment.

3.4.3 Applying the mastoid electrodes

Before placing the cap on the child’s head, you have to apply the ‘mastoid electrodes’. These
electrodes are also indicated by the names ‘EXG1’ and ‘EXG2’ (or EX1 and EX2; see IMAGE 3.12). These
are two separate electrodes, and are not part of a larger bundle.

The mastoid electrodes have to be placed behind the ears of the infant, on the ‘mastoid’. This is the
most bony area behind the ear, where presumably no (or few) signals from the brain are received. In
an EEG experiment, all electrodes on the left hand side are usually indicated by an odd number, and
all electrodes on the right hand side are usually indicated by an even number. This means that EXG1
has to be placed behind the left ear, and EXG2 has to be placed behind the right ear of the child.

IMAGE 3.12 IMAGE 3.13 IMAGE 3.14

When applying the mastoid electrodes:

- First, put a little bit of alcohol onto a cotton pad (numbered ‘2’ and ‘3’ in IMAGE 3.7).

- Degrease the area behind the child’s ears by rubbing it gently with the cotton pad with alcohol.

- Take one of the electrode stickers (numbered ‘1’ in IMAGE 3.7).

- Stick it onto the electrode (as in IMAGE 3.13).

- Remove the white protection layer (as in IMAGE 3.14).

- Add alittle drop of gel in the circle in the middle (as in iMAGe 3.15). Do not forget to do this! It will
hurt the child if you forget to add gel. However, also make sure you don’t add too much gel.

- Try to feel with your fingers where the mastoid is located and stick the electrode onto the
mastoid (IMAGE 3.16).

- Insert the other end of the electrode into the BioSemi amplifier (circled in blue in IMAGE 3.20

- Watch out that the child doesn’t pull off the electrode right away!

IMAGE 3.16

Mastoid Process

IMAGE 3.15
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NOTE: You can also prepare the cap first, and try to squeeze the mastoid electrodes underneath the
cap afterwards to make sure the child cannot pull them off right away. A disadvantage of this method
is that it's harder to find the right location of the mastoids when the cap is already on the head. The
importance of the mastoid electrodes also depends on whether you will use the linked left and right
mastoid as reference for offline processing. Average reference may work fine. If you use the average
as a reference, you don’t necessarily need the electrodes on the left and right mastoid (for more
information about referencing your data, read this section).

3.4.4 Preparing the cap

After you have adjusted the mastoid electrodes, take out a cap in a size that fits the baby’s head
circumference. There are several cap sizes available, that can be distinguished by colour.

The available cap sizes in the Babylab are the following:

Colour Head circumference
Brown ‘ 34-38 cm
Pink/brown <D 36-40 cm
Light blue/pink @ 40-44 cm
Light blue @ 42-46 cm
Green/light blue ‘ 44-48 cm
Green ‘ 46-50 cm
Yellow/green <D 48-52 cm

Which size you need, can primarily be based on the age of the infant. If you have an indication of the
average head circumference of the age group you're testing, you won't have to measure every
infant’s head beforehand. There are plenty of online guides which predict the infant’s head size, for
instance this one, which also allows you to make a prediction based on gender. It is still
recommended to measure the head though, because not every child is the same. To measure the
head of the child you can use the yellow measuring tape from one of the plastic cabinets (K.13) or
from the kitchen cabinet (K.02).

After you've decided which cap to use, try to put on the cap in one go. Do it fast and try to avoid

having to adjust the position of the cap too much, because it might upset the baby. Make sure that
Czis right on top of the head, in the exact middle between the ears and between the tip of the nose
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and the back of the head. The Fp-electrodes should be in the front; the O-electrodes should be at the
back of the head. Take the ears through the little holes (only if it is possible) and fasten the cap with
the Velcro.

Next, fill up the syringe with gel and put a little bit of gel into each electrode (iMaGe 3.17). Make sure
the gel touches the scalp, so that a good connection can be made, but be gentle with the baby’s
head.

IMAGE 3.17 - IMAGE 3.18

Take one of the 32-electrode bundles (indicated with only a
letter and no numbers at the beginning of the strap). Insert
all electrodes into the corresponding holes in the cap,
indicated by letters, numbers and colours (IMAGE 3.18). Start
with the electrodes closest to the BioSemi amplifier, and
end with the ones furthest away to avoid the electrodes
from getting tangled. When looking at the electrode bundle,
you will see that one side has a red edge (indicated with an
arrow in IMAGE 3.19). By beginning with this side, you will
start with the electrodes on the left hand side (odd
numbers). By beginning with the other side of the bundle,
you will start with the electrodes on the right hand side of
the cap (even numbers).

After you've inserted all electrodes into the cap, insert the
other edge of the bundle into ‘A1’ on the BioSemi amplifier
(circled in green in IMAGE 3 .20). Press until the plastic white
‘wings’ on either side come up. Turn on the amplifier by
pressing the button circled in red in IMAGE 3.20. A blue light,
as circled in in IMAGE 3 .20, should start to burn
continuously. If the light flickers, this means that the
electrodes CMS and DRL aren’t attached properly and may
need more gel. Keep on adding more gel and pressing the cap to the head until the light stops
flickering.

IMAGE 3.19

NOTE: Good signal from CMS and DRL is very important. If these two are not well connected, your
signal will be messy and not usable!
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IMAGE 3.20

3.4.5 Preparing the cap without participant

When testing an infant, there are two ways to prepare the cap: directly on the infant’s head (as_
described above), or by preparing it before the participant arrives. Both methods have several
advantages and disadvantages. Preparing directly on the participant’s head allows for using a better
cap size, because you can choose the cap size after you've seen the baby’s head, but will require a lot
of patience and cooperation from the infant as you adjust the electrodes one by one on its head.
Preparing before the appointment is a faster, but also more sensitive option as you won’t know the
baby’s head size or amount of hair before the appointment. This may result in having to prepare
directly on the infant’s head after all, if there are too many errors to start the experiment. Also, note
that after a certain age, the signal will become too noisy when preparing the cap before the
appointment, due to the development of a thicker skin. Read this section to see which method works
best for which age group.

If you decide to prepare the cap before the participant arrives, you can use a small ball (e.g. from
Action) on a non-metal object (such as a porcelain teapot) as a substitute for the infant’s head. Place
the cap inside out on the ball (as in IMAGE 3.21). Insert gel into all holes using the syringe (as in IMAGE 3
.22). Fill the holes all the way to the edge, to make sure a decent connection can be made.

Next, turn the cap inside out again (IMAGE 3.23). Take out the 32-electrode bundle and insert all

electrodes in the corresponding holes (IMAGE 3.24). Start with the side that will be closest to the
BioSemi amplifier.
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IMAGE 3.21

& A 2
IMAGE 3.23 IMAGE 3.24

Turn the cap inside out again, and add a little more gel to all electrodes in the same way as in IMAGE
3.22. Leave the cap like this until the participant has arrived.

After you have received the parent and the baby, follow the first part of the procedure as described
above (apply the gel on the wrist, explain the procedure, apply the mastoid electrodes). After you're
finished, adjust the prepared cap onto the baby’s head in one go. Do it as fast and precise as possible
to try to prevent the baby from getting upset. Also, make sure that the position of the cap is
immediately right, as adjusting it may cause a connection between electrodes because of the gel.
Make sure that Cz is right on top of the head, in the exact middle. The Fp-electrodes should be in the
front; the O-electrodes should be at the back of the head. Take the ears through the little holes and
fasten the cap with the Velcro. Stick the other end of the electrode bundle into the BioSemi amplifier
(circled in green in IMAGE 3.20). Turn on the amplifier and check if the blue light isn’t flickering (circled
in in IMAGE 3.20).

3.5 Checking the signal

3.5.1 CMS and DRL

After all the electrodes are adjusted properly, it is time to check the signal. The first check is the blue
light on the BioSemi amplifier (circled in in IMAGE 3.20). If this light is flickering, it indicates that
the electrodes CMS and DRL are badly connected. These electrodes do not give you data, but form a
feedback loop which acts as a reference and reduces the noise. Without a good CMS/DRL
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connection, your EEG measurements will be useless. Therefore, always make sure the blue light on
the BioSemi is stable.

3.5.2 ActiView

After making sure that the CMS and DRL are working properly, it is time to start ActiView. Open up
ActiView on the EEG1 (K.13)/Recording (K.02) computer. Before you start recording, make sure you
have loaded the correct configuration file. A pop-up will open automatically in which you can select
the correct configuration file. Go to ‘Desktop’, click ‘Configuration file’ and select
‘Infant_32channels.cfg’.

On your monopolar display, press ‘start’ (circled in in IMAGE 3.25). You will find that for each
selected electrode, the signal is displayed on the screen (circled in red). Set the reference to Cz, by
selecting ‘Free choice’ under ‘Reference’ (circled in green in IMaGe 3.25) and selecting Cz in the list
underneath. Check the signal for each electrode. The flatter the signal, the better. If you notice that
one or more signals are very noisy, try adding more gel to that particular electrode, but not too much
as you don’t want two electrodes to be connected through the gel. If you find that all signals are
extremely noisy, add more gel to CMS and DRL or press the cap a little firmer onto the head with
your hands. If the overall signal is better when you don'’t select Cz as your reference, consider adding
more gel to Cz. If you've tried to add gel to an electrode for a maximum of three times without
seeing a significant improvement, remove the electrode from your display. You can do this by
selecting ‘Free Choice’ under ‘Channels’ (circled in in IMAGE 3.25, enlarged in IMAGE 3.26), and
deselect the particular electrode by pressing CTRL and selecting the channel from the list
underneath. The data for this channel will still be saved, even though it is removed from the display.

'.':'"i : ﬂ
el o

IMAGE 3.25 IMAGE 3.26

While checking the signal, also look at the impedance by clicking ‘Electrode offset’ in the toolbar. Set
the displayed range to 50 mV (circled in in IMAGE 3.27). You should see that the bars turn to
blue. All bars should be within the range of +25 mV and -25 mV. The closer to zero, the better the
signal. If one of the bars is above +25 mV or below -25 mV (for instance the bars circled in red in
IMAGE 3.27), consider adding more gel to the corresponding electrode. If you see that one of the bars
is very unstable, also consider adding more gel to that particular electrode or remove it from the
display.

NOTE: it may be difficult to get all electrodes with good signal when testing infants. Researchers are
usually only interested in some electrodes rather than all. For instance, MMN is mostly visible at
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frontal-central electrodes. Hence, if the electrodes at the parietal and occipital locations are noisy, it
is not worth it to spend a lot of time adjusting these electrodes, as children very easily get annoyed
by people working on their head. Researchers need to be aware of the trade-off between a very good
signal and crying babies. In addition, if you use left and right mastoids as reference, a few noisy
electrodes can be tolerated, but if you want to use average reference in offline processing, decent
signal from all electrodes is needed, otherwise your reference will not be accurate.

Py

woGE
IMAGE 3.27

3.6 Testing

3.6.1 Startrecording (EEG1/Recording computer)

After you have checked the signal and everything is looking as good as possible, it is time to start
testing. Close the door between the test room and the control room. NOTE: When testing in K.02,
make sure you push the door handle upwards after closing it to secure the cabin is soundproof!

Press ‘Start File’ in the bottom right corner of ActiView (circled in blue in IMAGE 3.25). A dialog pops up
in which you have to type the participant number (IMAGE 3 .28).

= Sclock ST 2 Type your participant number in the box under both ‘Enter Local
ol are e Subject Identification’ and ‘Enter Local Recording Identification’.
Press ‘OK’. After this, you will be able to select a folder in which
& | you want to save the recording, type the same participant
T — number again as the file name. Click “OK”.
(8D chareters max )
<=0 NOTE: After you've pressed OK, you are not recording yet! Click

‘Pause Save’ at the right bottom corner of the screen when you

Sove subact- want to start your recording. The buttons should look like the

Al-Az2 () | ones in IMAGE 3.29, otherwise you are not recording!
[¥| Acd 8EX siectrodes v o
™ Acd Dispiayed Sznsars [~ Boxz
I Add Displayed Jazz Chan [T Boxa
™ AddDisplayed AIB Chen [~ Boxa
0K I Cancel
IMAGE 3.28 IMAGE 3.29
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3.6.2 Start experiment (EEG2/Presentation computer)

Once you've made sure that you are actually recording, start your experiment in Presentation on the
EEG2 computer. Click ‘run’, type in the participant number and press ‘enter’. Keep on pressing ‘enter’
until the sound starts playing.

Return to the ActiView screen and check whether the triggers are sent. You can see this in the
window circled in red in iIMAGE 3.30. A colour or number should appear (depending on your settings)
every time a stimulus is played. You can adjust the settings by selecting something else in the window
circled in green in IMAGe 3.30. This will not affect your data, but will only change your current view. If
you do not see any triggers appear, stop the experiment and call lab support. Without triggers
being sent, no offline processing can be performed, so you are recording for nothing!

You can always stop the experiment in Presentation halfway by pressing the Esc button. This will stop
the entire block you were running. If a block has ended, press ‘enter’ a few times again to proceed on
to the next block. It won't be possible to pause a block and continue later. However, you can restart a
block by starting the experiment again and skip the previous blocks (press ‘enter’ and ‘esc’ right after
each other when starting a new block). Keep in mind that the log files from your experiment will
overwrite themselves when restarting the experiment. If you want to keep those, make sure to copy
them before you restart your experiment.

IMAGE 3.30

Once the recording has finished, press “pause save” at the right bottom of the screen, and then press
“stop” at the up left of the screen.

3.7 Cleaning

After you completed the testing phase, remove the cap from the infant’s head and take off the
mastoid electrodes. Guide the parent and child to the washing room and show them the towels and
shampoo, or give them a Zwitsal paper cloth if they don’t want to wash the hairs immediately (this is
usually enough cleaning for the youngest children without many hairs). Before you say goodbye to
the parent and child, take them back to the waiting area and give them a gift (usually a book that’s
appropriate for the child’s age) and reimburse travel expenses (if applicable). For more information
about this, read the waiting area protocol. Also, give the parent the opportunity to ask any questions
they may have.

Afterwards, fill the two plastic washtubs with lukewarm water (IMaGe 3.31). Remove the electrodes
from the cap and gently place them into the water. Do not let the electrodes sit under running

22



http://www.hum.uu.nl/uilots/lab/resources/protected/Babylab/Waiting_area.pdf

BABY EEG: PROTOCOL FOR TESTING AND/ANALY] 3 UTRECHT

water! Use the softest toothbrush to gently clean the electrodes. Pat dry viece of paper
towel. Hang the bundle back to it's place and put the end with the electro
prevent them getting (sun)light;  image 3.32 image 3.32). S
Place the cap in the other washtub. Use the other brush to remove the gel: ‘TN oles in the cap.
Hang the cap up to dry on one of the hooks above the sink.

Fill the syringe a few times with lukewarm water and press it empty to re " je gkl in the tip.

IMAGE 3.31 o o o IMAGE 3.32

3.8 Replacing the battery

After a few appointments, you may get an error message in ActiView stating that your battery is low.
There is always an extra battery in the control room, on the right hand side of your desk. Here, you
will also find the charger.

The battery of the BioSemi amplifier is the large block underneath the block in which you plug in the
electrode bundles (iMaGe 3.). First, remove the cable circled in red in iMace 3.by pulling it out. Then
remove the cable circled in green, by (gently) pushing and turning it. Disconnect the battery from the
amplifier by clicking all four black locks sideways and up. Take the battery to the control room.

IMAGE 3.33
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In the control room, you'll find a spare battery and the charger (iMaGe 3.). Connect the empty battery
to the charger by connecting the blue parts (circled in green in iMAGe 3.) and plug the charger into the
socket. Don’t forget to unplug it once the battery is fully charged again! Take the spare battery back
to the amplifier and connect it to the amplifier by adjusting the two cables and the four black locks

again.
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4. Guidelines for testing different age groups

Testing infants may be quite challenging and approaches can differ widely as infants grow older.
Therefore, it is always necessary to search for the correct approach when starting an experiment
with a new age group. So far, we have personally experienced what it’s like to test 4-, 12- and 20-
month-old infants. In this chapter, we’d like to share our experience and provide certain guidelines
on how to deal with these age groups. Note that no matter the age group, a bubble blower will make
all children happy. Use this as your first choice munition in any bad situation.

4.1 How to test 4-month-olds

At 4 months, infants have just gained control over their heads and cannot sit down properly yet.
Therefore, they have to sit on their parent’s lap during the experiment instead of in a high chair. A
problem with this, however, is that infants tend to lean against their parent’s stomach, which may
cause a lot of noise in the signal. Ask the parent explicitly to prevent this as much as possible.
Because their motor skills haven't quite developed yet, you won't have to worry about them wanting
to run away from the table. Instead, there’s a big chance that the child will cry during the
experiment. If it does, try distracting the child, for instance with a bubble blower. If this doesn’t work,
check with the parent whether it may need something. The child may be hungry or may need a
diaper change, which are problems that can easily be solved after which you can continue the
experiment. If the child is tired, however, it will be more difficult to continue the experiment and you
may want to consider aborting it.

As far as the preparation of the cap is concerned, our experience is that the preparation before the
appointment works best for 4-month-olds. Preparation directly on the infant’s head can take quite a
long time, and 4-month-olds tend to get restless pretty quickly. Also, the signal of the pre-prepared
cap is quite similar as to the one that's prepared immediately onto the infant’s head. Preparing the
cap before the appointment therefore saves a lot of time and frustration for the child. You can apply
the mastoid electrodes first, and then put the prepared cap onto the head in one go. Make sure you
immediately get the position right, as readjusting it may cause bridges between two electrodes.

Best cap size: blue/pink

4.2 How to test 12-month-olds

At 12 months, infants have gained a lot more motor skills already and some may have even started
walking a little bit. This can be pretty cute, but the consequence of this is that they also want to move
around and explore during your experiment, whereas you really want them to sit still. Make sure
there is enough distraction for them as you put the cap onto their heads. You could for instance play
Dora the Explorer on the screen, or have toys on the table for them to play with. If the infants aren’t
allowed to play during the experiment, however, be careful when providing them with toys, as they
may get upset when you take the toys away from them before the experiment starts. Instead, choose
to play something fun on the screen.

For this age group, it also works best to prepare the cap in advance, to make sure they don’t have to
sit still for a long time as you prepare the cap onto their heads. Be careful though with children who
already have a lot of hair, as it may be more difficult to get a clean signal this way.

Best cap size: blue

4.3 How to test 20-month-olds

At 20 months, infants can already walk and they have started talking a little bit. You will notice that
these children also have become much more aware of what is happening to them, and differences in
character will be clearly visible. The word ‘no’ is especially well-known, and they won't think twice
about using it whenever they can. At this age, it is far more important to talk to them directly as
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opposed to the younger infants. Whereas you could still put the cap onto their heads without saying
anything when they were just 12 months old, they now demand an explanation and a certain degree
of autonomy from you. Below, you will find an overview of the tricks we used while testing 20-
month-olds:

Make the EEG caps look more child friendly, for instance by giving all the stuffed animals in the
room an EEG cap as well.

Decorate two caps of the correct size with child friendly figures, for instance flowers and stars,
and let them choose which cap they want to put on their head. Make them believe they have a
choice in the matter.

As soon as the child walks into the room, point your attention directly to the child and explain to
the child that all their stuffed animal friends wear beautiful caps, and they want to play a game
with the child, but then the child gets to wear a cap too. Explain to them that they can choose
which cap they want. Always be enthusiastic and point out all the nice things about wearing a
cap.

If the child is very shy or actively refuses to make a decision, take more time for this part and try
to involve the parent. For instance, ask the parent if they also want to wear a cap, or put one on
your own head as well to show the child it isn’t harmful. Another thing you can do is let the child
choose if either you or the parent should put the cap onto the child’s head. Make sure you
instruct the parent on how the cap should be placed.

Once you have tricked the child into wearing the cap, first clean their skin behind the ears with
alcohol before you proceed to put the cap onto their head. As soon as you have put the cap on,
start a video with children’s songs to distract the child immediately. Our experience is that they
will totally forget that they have something on their head as soon as they hear the songs.

While the infant is listening to the children’s songs, you can put a little bit of gel onto the child’s
wrist, explain to the parent what you are going to do and afterwards check the child’s wrist again
for any allergic reactions. If there aren’t any, you can start the preparation of the cap by inserting
the gel into the holes.

Note that preparing the cap before the appointment does not work for this age group, as their scalp
has become thicker and they have gained a lot more hair. Therefore, more distraction is needed to
keep them from getting upset while undergoing the preparation.

Best cap size: green/blue for girls, green for boys
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5. Analysis

5.1 Getting started

5.1.1 Downloads

After you have tested enough participants, it is time to analyse your data. Before you start, make
sure you've installed the following programmes on your computer:
e The EEG analysis server (ask ICT & Media for the download and for adding you as a user to
the server)
e EEGLAB (download)
¢ The following plugins:
- BIOSIG data import (download)
- Grandaverage (download)
- ERPLAB (download)

Once ICT & Media has given you access to the EEG analysis server, open the server by inserting your
username (‘SOLISCOM\[your solis-ID]’) and solis password. While in the server, download EEGLAB.
Save the file in your personal user folder on the D: drive. NOTE: Always save it in this folder while in
the EEG analysis server, otherwise you won't be able to access it!

After downloading EEGLAB, install the other plugins. Save the files in the following folder:
‘Computer/D:/Users/[your solis-ID]/eeglab13_6_5b"/plugins/’. Make sure you unzip the ERPLAB and
grandaverage plugin before saving it in the ‘plugin’ folder. Your directory should now look similar to
IMAGE 5.32.

B plugins =]
9( )v| .+ Computer = DATA (D:) = Users ~ 3537668 - eeglab13_6_5b - plugins = - lmll Search plugins Eﬂ
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IMAGE 5.32

5.1.2 Copy your data to the server

Copy your raw data to your user folder (D: drive) on the analysis server. From here, you will do all the
analysis.

! This could have a different name if you're using a different version of EEGLAB
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5.1.3 Starting EEGLAB

Next, open MATLAB, which is already installed on the EEG analysis server. Click ‘Set Path’ in the
toolbar (circled red in IMAGE 5.33).

) MATLAB R2015b - academic use =] &3
] |:|' :j r Lk New Variable L Analyze Code o] j 2]
s T [ Fnaries & H - Wi () (% Community
E Open Variable v éf Run and Time
New New Open @ Compare  Import Save Simulink Add-Ons  Help i:} Reguest Support
Seript w - Data Workspace ) ClearWorkspace ~  [*7 Clear Commands =  Library - -
FILE VARIABLE CODE SIMULINK ENVIRONMENT RESOURCES
< = 037 » D: b Users b 3537668 » Documents b MATLAB -0
Current Folder [GRNl| Command Window [GN | workspace @
|Nama A | New to MATLAB? See resources for Getting Started. X | ||Mame - IVaIue
Bcademic License
fx >>
~ 1 | »
A| Ready /ﬁl
IMAGE 5.33

Click ‘Add Folder’ (circled in red in IMAGE 5.34). Set the path to the folder where you saved EEGLAB
(circled in green). Click ‘Close’ (circled in blue). When asked to save the path, click ‘no’, as saving is
not possible.

NOTE: because saving isn't possible, you have to do this again every time you start MATLAB.

) Set Path =]

All changes take effect immediately.
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IMAGE 5.34

After setting the path, type ‘eeglab’ into the command window (circled in red in iMAGE 5 .35). Press
‘enter’.
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IMAGE 5.35

A new window opens, similar to the one in IMAGE 5.36. You are now ready to start analysing!

EEGLAB v13.6.5b =1 E3
k|

File Edit Tools Flot Study ERPLAB ERPsets Datasets Help

— No current dataset

— Create a new or load an exXisting dataset:
Use "File > Import data™ (new)
Or "File > Load existing dataset™ ([(old)

— If new,
"File > Import epoch info"™ (data epochs) else
"File > Import event info™ (continuocus data)
"Edit > Dataset info" (add/edit dataset info)
®File > Save dataset"™ (save dataset)

— Prune data: "Edit > Select data®™

— Reject data: "Tools > Reject continuous data™

- Epoch data: "Tools > Extract epochs™

— Remove baseline: "Tools > Remove baseline”™

— Run IC&: "Tools > Run ICA"™

IMAGE 5.36

5.2 Epoching

First of all, you need to upload your raw data. Import your data by using the BIOSIG toolbox, as seen
in IMAGE 5.37. Go to the folder where you saved your raw data files and select one of the .bdf files.
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EEGLAB v13.6.5b H[=]
lﬁ Edit Tools Flot Study ERPLAB ERFsets Datasets Help £
Using EEGLAE functions and pluging » From ASCIIffloat file or Matlab array
Importepochinfo »  Using the FILE-IO interface From Metstation binary simple file
4 Using the BIOSIG interface From Multiple seg. Metstation files
4 Troubleshooting data formats... From Metstation Matlab files
TETIe > Import gatar From BCI2000 ASCII file

M"File > Load existing dat From Snapmaster .SMA file

W, From Neuroscan .CNT file

> Import epoch info™ (de  From Meuroscan .EEG file

Create study »

> Import event info" (cc [ EEEUlEEE RN ER (R (Rl 105
Load existing study > Dataset info" (add/ed; From EDF/EDF-/GDF files (BIOSIG toolbox)

(=

> Save dataset™ (save dataset)

data: "Edit > Select data™

Memary and other options £ data: "Tools > Reject continucous data™

History scripts p» | data: "Tools > Extract epochs"

Manage EEGLAB extensions # B baseline: "Tools > Remove baseline™

Quit CL: "Tools > Run ICA™

IMAGE 5.37

Another window opens, similar to the one in IMAGE 5.38. While uploading, set the reference to Cz,
which is the electrode in the very middle of the cap. In MATLAB, all electrodes are numbered and
referred to by their corresponding numbers. You can find an overview of the electrodes and their
corresponding numbers here. You can see that the corresponding number to Cz is 32. Set the
reference to Cz by typing ‘32’ into the white box circled in red in IMAGE 5.38. Leave the rest as it is,
and press ‘OK’.

Load data using BIOSIG -- pop_biosig() =] &

Channel list (defaut all): |
Data range (in seconds) to read (default all [0 1899]) |
Extract event

Import anotations (EDF+ only)
Force importing continuous data

v
v
r
Reference chan(s) indices - required for BIOSEMI

I Import as memory mapped file (use if out of memory error)

Help | Cancel| Ok |

IMAGE 5.38

You will be asked to give up a name for your new dataset. In this example, we will use the fictive
name ChildX (IMAGE 5.39).

Dataset info -- pop_newset() =]

What do you want to do with the new dataset?

Nameit | ChildX Editdes...l
Help| Cancel| Ok |

IMAGE 5.39

After uploading your dataset, you should see that there are 40 channels per frame (circled in red in
IMAGE 5.40), and that the reference is set to Cz (circled in green in IMAGE 5 .40).
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NOTE: Do you see 72 channels per frame? Click here to find out what to do.
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File Edit Tools Plot Study ERPLABE ERPsets Datasets Help

I[=] E3

—#1: ChildX

Filename: none
Channels per frame
Frames per epoch
Epochs

Events

Sampling rate (Hz)
Epoch start (sec)
Epoch end (sec)
Reference

Channel locations
ICA weights

Dataset size (Mb)

3969024
1
1628
2048
0.000
1938.000
No (labels only)
Ho

667.8

IMAGE 5.40

5.2.1 Filter the data

The next step is to filter your data. This is done in order to filter out the low and/or high-frequency
artefacts in the data. We choose a bandpass filter to filter out all data below 0.3 and above 20Hz.

Note that the type of filter and filter range depends on the component that you are interested in and

the age of the children, and should be determined per experiment. Select ‘Basic FIR filter (new,

default)’ as depicted in IMAGE 5 .41. A dialog will open similar to IMAGE 5 .42. Insert your lower edge and

higher edge and click ‘Ok’.

EEGLAB v13.6.5b

File Edit |Tools Plot Study

ERPLAB ERF==t= Datasets Help

I[=1 E3

Change sampling rate | .

—
Re-reference
Interpolate electrodes
Reject continuous data by eye
Extract epochs

Basic FIR filter (new, default)

Windowed sinc FIR filter
Parks-McClellan (equiripple) FIR filter
Moving average FIR filter

Basic FIR filter (egacy)

Remove baseline
Run ICA

Remove companents

Automatic channel rejection
Automatic continuous rejection

poch rejection

Rejec epochs ]
Reject data using ICA ]
Locate dipoles using DIPFIT 2.x b
Grand average datasets ]

IO WeEIgIT

Dataset =size (Mb)

TTToUT
1
1628
250
0.000
1837.59596
Cz
No (labels only)
No

82.4

IMAGE 5.41
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Lower edge of the frequency pass band (Hz)

Higher edge of the frequency pass band (Hz)

FIR Filter order (Mandatory even. Default is automatic™)

I Notch filter the data instead of pass band

™ Use minimum-phase converted causal filter (non-linear!; beta)
I Plot frequency response

Help |

[ 03
[ 20
S

*See help text for a description of the default filter order heuristic.
Manual definition is recommended.

Ok

I[=] 3

IMAGE 5.42

Name the new dataset as you prefer. A new dataset will open in the old dialog again. As you will
notice, nothing has changed on the outside.

5.2.2 Change the sampling rate
The sampling rate of the data gives the number of samples per second. By default, the sampling rate
of the BioSemi is set at 2048Hz. This accounts for extremely large datasets; as you can see in IMAGE
5.40, the size of this dataset is 667.8 Mb. Therefore, it is necessary to change the sampling rate to a
lower rate, but still keep it high enough to give you enough detail for your analysis. For our research,
we would like to change the sampling rate to 250Hz. For your own research, this number may differ.

If you would like to change the sampling rate, go to ‘Tools’ and click on ‘Change sampling rate’ (IMAGE

5.43).
EEGLAB v13.6.5b M= E3
File Edit |Tools Plot Study ERPLAB ERPzetz Datasets Help £

Change sampling rate
Filter the data 4
Rereference
Interpolate electrodes
Reject continuous data by eye A
Extract epochs
Remove baseline HHFHE
Run ICA 1
Remove components 1628
Automatic channel rejection 2048
Automatic continuous rejection
; S 0.000
Rejec he » 1938.000
Reject data using ICA 3 cz
Locate dipol ing DIPFIT 2.x b
ocate dipoles using X No (labels only)
Grand average datasets ]

TeEweTgIT No

Dataset size (Mb) &667.8

IMAGE 5.43

A window will open similar to
IMAGE 5 .44. Insert your desired
sampling rate in Hz and click
‘oK.

Resample current d... =] E3

New sampling rate
| 250

Hep|  can_| Ok |

IMAGE 5.44

32



BABY EEG: PROTOCOL FOR TESTING AND ANALYSIS | BABYLAB UTRECHT

Dataset info -- pop_newset() =]

What do you want to do with the new dataset?
ChildX resampled

Name it: |

Edit description |
Browse |

Some changes have not been saved. What do you want to do with the old dataset?

~ Save it as file: |

- Overwrite it in memory (set=yes; unset=create a new dataset)

- Save it as file: | Browse
Help | Cancel | Ok |

IMAGE 5.45

A window opens which will ask you to give a name to your new dataset (IMAGE 5 .45). By default,
EEGLAB adds ‘resampled’ after the previous name. You can either choose to accept this, change it to
a different name, or change it to the previous name by removing ‘resampled’. Click ‘Ok’.

NOTE: Every time you change something to your dataset, a new dataset will be created and you will
be asked to give up a name for your new dataset in the same way as in IMAGE 5.45. In order to
remember what is different about each dataset, the advice is to always add something after the
child’s name which reminds you of the step you took in creating this dataset. Sometimes EEGLAB
does this by default, but not always.

EEGLAB v13.6.5b
File Edit Tools Plot Study ERPLAB ERPsstsl| Datasets fHelp N

—#2: ChildX resampled

Filename: none

Reference

Channel locations

Channels per frame 40
Frames per epoch 484500
Epochs 1
Events 1628
Sampling rate (Hz) 250
Epoch start (sec) 0.000
Epoch end (=sec) 1537.5896

Cz

No (label= only)

ICA weights No
Dataset size (Mb) 82.4
IMAGE 5.46

Your new dataset will open in the same dialog as your previous dataset (IMAGE 5 .46). By clicking on
‘Datasets’ (circled in green) you can switch between datasets. You can see in your new dataset that
the sampling rate has been changed to 250 (circled in red). Consequently, the size of your dataset
has also become smaller (circled in blue).

5.2.3 Add channel locations
The next step is to add the channel locations to your dataset. Adding channel locations will give you
the opportunity to plot your ERP data in the correct place in the scalp. You can add channel locations
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by clicking ‘Channel locations’ via ‘Edit’ (IMAGE 5.47). A new dialog will open as in IMAGE 5.48. The
correct file will already be loaded by default, so you shouldn’t have to do anything. Click ‘Ok’.

EEGLAB v13.6.5b | _ (O] x|
File | Edit Tools Plot Study ERPLAB ERPsei= Datasets Help u
Dataset info
[ Eventfields d
Event values
About this dataset
Channel locations
40
Select data
Select data using events LR
Select epochs or events 1
Copy current dataset 1628
Append datasets sxm
Delete dataset(s) from memory
TOOCIT SCArC [SEC] 0.000
Epoch end (sec) 15837.9396
Reference Cz
Channel locations No (labels only)
ICR weights Ho
Dataset size (Mb) 82.4
IMAGE 5.47
Look up channel locations? M=

Only channel labels are present currently, but some of these labels have known
positions. Do you want to look up coordinates for these channels using the electrode
file below? If you have a channel location file for this dataset, press cancel, then

use button "Read location” in the following gui. If you do not know, just press OK.

use BESA file for 4-shell dipfit spherical model j
D \Wsers\3537668\eeglab13_6_5b\plugins\dipfit2. 3\standard_BE

Help | Cancel | Ok |

IMAGE 5.48

After clicking ‘Ok’, a new window will open similar to IMAGE 5.49. You will see that all the information

about the location of each channel is already inserted. Click ‘Ok’.

Edit channel info -- pop_chanedit() == 3
Channel information ("field_name"):
Channel label ("label") Fp1 Opt. head center
Polar angle ("theta") -17.926 Rotate axis
Polar radius (‘"radius") 0.51499 Transform axes
Cartesian X ("X") 80784
Cartesian Y ("Y") 26.133 Xyz > polar & sph.
Cartesian Z ("Z") -4.0011 Sph. -> polar & xyz
Spherical hariz. angle ("sph_theta") 17.926 Polar -> sph. & xyz
Spherical azimuth angle ("sph_phi") -2.698
Spherical radius ("sph_radius") 85 Set head radius
Channel type Set channel types
Reference Set reference
Index in backup 'urchanlocs' structure 1
Channel in data array (set=yes) i
Delete chan Channel number (of 40)
Insettchan | 77EET| < | 1 > | >> | Appendchan |
Plot 2-D Plot radius (0.2-1, [I=auto) | INose along +X j Plot 3-D (xyz)
Read locations | Read locs help | Look up locs | Save (as .ced) | Save (omertypes)|
Help Cancel Ok
IMAGE 5.49

34



BABY EEG: PROTOCOL FOR TESTING AND ANALYSIS | BABYLAB UTRECHT

This time, no new dataset will be created. You will find that the channel locations have been added
to the old dataset (circled in red in IMAGE 5 .50), which you created after filtering the data.
Consequently, another thing that has changed to your dataset is the reference. As you will find, the
reference is now unknown (circled in green in IMAGE 5.50).

File Edit Tools Plot Study ERPLABE ERFPset= Datasets Help o
—=#3: ChildX Filtered
Filename: none
Channels per frame 40
Frames per epoch 484500
Epochs 1
Events 1628
Sampling rate (Hz) 250
Epoch start (sec) 0.000
Epoch end (sec) 1937.996
Reference | unknown
Channel locations Yes
ICA weights Ho
Dataset size (Mb) 82.4
IMAGE 5.50

5.2.4 Select channels

So far, our dataset has consisted of 40 channels. These are the 32 channels which were placed on the
cap, and EXG1-EXG8. As you remember, we only used EXG1 and EXG2 while recording (these were
the electrodes that were placed on the mastoids), which means that the other six are empty.
Therefore, you have to remove these empty channels from the dataset.

At this stage, you should also decide what you want to use as a reference. When referencing your
data (at a later stage), you can either choose to use the mastoid electrodes (EXG1 and EXG2), or use
the average of the 32 electrodes on the cap. Note that when choosing the mastoid electrodes as your
reference, they need to be perfectly attached for all participants. As infants are more tempted to pull
these electrodes off while testing, EXG1 and EXG2 are usually less reliable in infants compared to
adults. Therefore, in our research, we will use the average of the 32 remaining electrodes as a
reference instead. Because we do not need EXG1 and EXG2 for our data anymore, we should remove
all EXG-electrodes and only select the 32 channels that were on the cap.

To (de)select channels, go to ‘Edit’ and click ‘Select data’ (as in IMAGE 5 .51).
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EEGLAB v13.6.5b M=l E3
File |Edit Tools Plot Study ERPLAB ERFsctz Datasets Help ~
Dataset info
[  Eventfields d

Event values

About this dataset

Channel locations

40

Select data

Select data using events i

Select epochs or events 1

Copy current dataset 1628

d datasets

Append datase 550

Delete dataset(s) from memary
TOOCIT SCArT [SECT 0.000
Epoch end (sec) 1937.996
Reference unknown
Channel locations Yes
ICA weights No
Dataset size (Mb) 82.4

IMAGE 5.51

A new dialog opens which gives you several options for selecting data. Choose the last option,
‘Channel range’, to select the channels that you are interested in. There are several options for your
input into the blank space:
¢ |f you know the numbers that correspond to the electrodes, you can type in the individual
numbers with spaces in between (e.g. 1 2 3 32).
¢ |f you wish to select the whole range between two electrodes, you can type the first and last
number with a colon (:) in between (circled in blue in IMAGE 5 .52).
¢ |f you do not know the corresponding numbers, you can select the channels by label by
clicking the button circled in red in IMAGE 5 .52.
* You can also decide to insert the electrodes that you want to remove from your set. You can
select this option by ticking the checkbox circled in green in IMAGE 5 .52. In this case, you only
have to select EXG1-EXG8 (or 33:40), tick the box and press ‘Ok’.

Select data -- pop_select() =]
Select datain: Input desired range on->remove these
Time range [min max] (s) | .

Point range (ex: [1 10]) u

) 0C

Scroll dataset |

Help | Cancel Ok

IMAGE 5.52

|
Epochrange (ex: 3:2:10) |
|

Channel range

A new dataset will be created again. As you will find, it now contains only 32 channels (circled in red
in IMAGE 5.53).

36



BABY EEG: PROTOCOL FOR TESTING AND ANALYSIS | BABYLAB UTRECHT

File Edit Tools Plot Study ERPLAB ERPset= Datasets Help £
— #4: ChildX 32chan
Filename: none
Channels per frame
Frames per epoch 484500
Epochs 1
Events 1628
Sampling rate (Hz) 250
Epoch start (sec) 0.000
Epoch end (sec) 1937.996
Reference unknown
Channel locations Yes
ICA weights Ho
Dataset size (Mb) 66.9
IMAGE 5.53

5.2.5 Epoch the data

By now it is time to epoch your data. To epoch means to break your large string of data into smaller
strings, based on the timeframes in which the stimuli (or ‘events’, as EEGLAB calls them) occurred. As
you can see, your dataset now contains only one epoch, which means that there is only one
extremely large string of EEG data. An epoch usually begins a few milliseconds before the onset of
the stimulus, and ends after the ERP response should have occurred. In this example, we choose our
epochs to start 100ms before the onset of the stimulus and end 900ms after the onset of the
stimulus.

In the experiment that is used as an example, there were 9 different types of stimuli:

Event number | Stimulus type

1 Lexical tone: standard that immediately follows a deviant
2 Lexical tone: standard that follows another standard

3 Lexical tone: deviant

4 Music: standard that immediately follows a deviant

5

6

Music: standard that follows another standard
Music: deviant

13 Vowel: standard that immediately follows a deviant
14 Vowel: standard that follows another standard
15 Vowel: deviant

Because of the uncertainty that the ERPs following the numbers 1, 4 and 13 (standard after deviant)
really represent the ERPs following a standard stimulus, we are only interested in the numbers 2, 3,
5, 6, 14 and 15. Therefore, we will only extract the timeframes surrounding these stimuli from the
large dataset.

To epoch your data, go to ‘Tools’ and click ‘Extract epochs’ (IMAGE 5 .54).
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EEGLAB v13.6.5b =1
Fie Edit |Tools Plot Siudy ERPLAB EfPscis Datasets Help ~
Change sampling rate
Filter the data 4
Rereference
Interpolate electrodes
Reject continuous data by eve

32

Extract epochs
Remove baseline R
Run ICA 1
Remove components 1628
Automatic channel rejection Prn)
Automatic continuous rejection
. 0.000
Rej » 1937.59596
Reject data using ICA 3 ElerEr
Locate dipol ing DIPFIT 2.x k
ocate dipoles using X Tz
Grand average datasets »
ToEWEIgIT No
Dataset =ize (Mb) 66.9

IMAGE 5.54

A new dialog will open, similar to the one in IMAGE 5 .55. Specify which events you want to select,
either by typing in the corresponding numbers with spaces in between or by clicking the button
circled in red in IMAGE 5.55. Also, specify what the timeframe should be. Because we want the epoch
to start 100ms before the onset of the stimulus, and end 900ms after the onset of the stimulus, we
typed -0.1 0.9’ in the blank space (circled in green). You can also immediately specify the name of
your new dataset (circled in blue). Click ‘Ok’.

Extract data epochs - pop_epoch() =]
Time-locking event type(s) ([J=all) | 23561415 l I
Epoch limits [start, end] in seconds | 01009
MName for the new dataset ChildX epochs

Qut-of-bounds EEG limits if any [min max] |

Help | Cancell Ok |

IMAGE 5.55

After the familiar window in which you will be asked to name and/or save your new dataset, a dialog
similar to iMaGe 5.56 will pop up. Don’t change anything. Click ‘Ok’.

Baseline removal - pop_rmbase() =] B3

Baseline latency range ([min max] in ms) ([ ] = whole epoch): | 1000

Or remove baseline points vector (ex 1:56) |

MNote: press Cancel if you do not want to remove the baseline

Help | Cancel | Ok |

IMAGE 5.56

As you will see, your new dataset now consists of many more epochs (circled in red in IMAGE 5 .57),
which all start 100ms before the stimulus and end 896ms after the stimulus (circled in green in IMAGE
5.57).
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File Edit Tools Plot Study ERPLAB ERPsets Datasets Help

M[=] E3

—#6: ChildX epochs

Filename: none
Channels per frame
Frames per epoch
Epochs

Events

Sampling rate (Hz)
Epoch start (sec)
Epoch end (sec)
Reference

Channel locations
ICA weights

Dataset size (Mb)

32

250

1273

1273

250

-0.100

0.896

unknown

Ho

42.4

IMAGE 5.57

5.2.6 Set the reference

Finally, we have to reset the reference. When uploading the file, the reference had to be Cz, but now

we set the reference either to the mastoid electrodes or to the average of all 32 electrodes on the

cap. When selecting the channels, you have already made the decision to select or deselect the EXG1

and EXG2 electrodes. If you've kept these in your dataset, you can set the reference to the average of
EXG1 and EXG2. If you removed these electrodes, you can set the reference to the average of the 32
remaining electrodes. In this example, we choose the last option.

In order to set the reference, go to ‘Tools’ in the toolbar and click ‘Re-reference’ (IMAGE 5 .58).

EEGLAB v13.6.5b

File Edit |Tools Plot Study ERPLAB ERPsets Datasets Help

I[=1 B3

Change sampling rate

Filter the data 4

Re-reference
Interpolate electrodes
Reject continuous data by eye

Extract epochs
Remove baseline

Run ICA

Remove components

Automatic channel rejection
Automatic continuous rejection
Automatic epoch rejection

Reject data epochs »
Reject data using ICA 3
Locate dipoles using DIPFIT 2.x #
Grand average datasets 3

TCE WeIgnT

Dataset size (Mb)

3z

250

1273

1273

250

-0.100
0.896

unknown

IMAGE 5.58

In order to set the reference to the average, tick the checkbox circled in red in IMAGE 5 .59 (this
checkbox will already be ticked by default). Click ‘Ok’.

NOTE: If you want to set the average to EXG1 and EXG2, tick the box ‘Re-reference data to
channel(s)’ and type in the corresponding numbers, or select the mastoid electrodes from the list.
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Next, select ‘Retain old reference channels in data’ to return Cz to your dataset, otherwise the
recorded data from this channel will be lost.
pop_reref - average reference or re-reference data M=l

Current data reference state is: unknown

ompute average reference

" Re-reference data to channel(s): |

" Retain old reference channels in data
Exclude channel indices (EMG, EOG) |

Add current reference channel back to the data |

Help | Cancel | Ok

IMAGE 5.59

mn B

This time, save your new dataset under the name ‘[ChildX]_epochs’ (IMAGE 5 .60). It will be saved as
a .set file, and you can upload it whenever you start MATLAB again to do the remaining analysis.

Up until here, all the analysis can be done with a script. You can either try to write your own script by clicking
‘New script’ in the MATLAB toolbar, or you can contact Ao Chen to ask for a standardised script. Don’t forget to
adapt her script to your own experiment!

Dataset info -- pop_newset() =]

What do you want to do with the new dataset?

Name it | ChildX average Edit description |

i Save it as file: [D-\Users\3537668\A0\MMN_UUlinfant\Li

Some changes have not been saved. What do you want to do with the old dataset?
u Overwrite it in memary (set=yes; unset=create a new dataset)

u Save it as file: | Browse |
Help | Cancel | Ok |

IMAGE 5.60

5.2.7 Problem: My dataset has 72 channels

If you uploaded a dataset, chances are that it contains 72 channels per frame instead of 40 (circled in
red in IMAGE 5.61). This happens when you forgot to use the 32-channel configuration file when
recording. Consequently, you'll find that the reference isn’t set to Cz, but to CPz (circled in green in
IMAGE 5.61). This is because the channels were incorrectly labelled due to the use of the wrong
configuration file. This means that CPz holds the information of the Cz electrode, but is labelled
differently.
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ERPset= Datasets Help

[=] E3

—#1: ChildY

Filename: none
Channel=s per frame
Frames per epoch
Epochs

Events

Sampling rate (Hz)
Epoch start (sec)
Epoch end (sec)
Reference

Channel locations
ICA weights

Dataset size (Mb)

3889152
1
1591
2048
0.000
1895.000
CPz
Ho (labels only)
Ho

1152.2

IMAGE 5.61

When you find that your dataset contains 72 channels, you will have to do a part of the

abovementioned analysis slightly differently.
The first part of the analysis (change your sampling rate and filter your data) can be done in the same
way as described above. After filtering, however, make sure you first select the channels you want to

use. Remember here that the labels do not correspond to the actual data. Instead, only the first 34

labels actually contain data; the remaining 38 labels are empty. If you wish to use EXG1 and EXG2 as
your reference, type ‘1:34’ in the field behind ‘Channel range’. If you wish to use the average as your

reference, type ‘1:32’ (circled in red in IMAGE 5 .62).

A Select data -- pop_select()

Select data in: Input desired range

Time range [min max] (s) |

u

Point range (ex: [1 10])

Epoch range (ex: 3:2:10) |
Channel range |

o

1:32 j

Scroll dataset |

Help

Cancel

on->remove these

JH[=] E3

.|

Ok

IMAGE 5.62

After selecting the number of channels you want to use, it is time to add the channel locations. Go to

‘Channel locations’ via ‘Edit’ (image 5 .63). A new dialog opens similar to IMAGE 5 .64. Click ‘Ok’.
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EEGLAB v13.6.5b =]

File |Edit Tools Plot Study ERPLAB ERPset= Datasets Help £
Dataset info

— 32

Event fields
Event values
About this dataset

Channel locations

32
Select data

Select data using events 474750

Select epochs or events 1
Copy current dataset 1591
Append datasets

250

Delete dataset(s) from memory
TOOCIT SCart [SECT 0.000

Epoch end (sec) 1898.996
Reference unknown
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IMAGE 5.64

Next, a new dialog opens in which all the labels are already loaded together with their locations on
the scalp (as in IMAGE 5.65). Remember, however, that these labels are wrong and therefore the
locations are wrong as well. This means you have to change all the labels manually. You can do this
by typing the correct label for each channel into the space circled in red in IMAGE 5 .65 (you can find
the label per channel here). Empty all the fields circled in green. You can see which channel number
you're editing in the field circled in . Go on to the next, or back to the previous channel by
clicking the arrows circled in blue. Once you are done, click ‘Ok’. Now, you have changed the labels,
but you haven't added the channel locations yet. Go to ‘channel locations’ again (IMAGe 5.63) and click
‘Ok’ again in IMAGE 5.64. You will see that the same dialog opens again as in IMAGE 5 .65, only now you
will find the correct labels and location information when you scroll through the channels. You can
also check this by comparing the numbers to this overview of the channel locations. Click ‘Ok’.

After adding the channel locations, you can break up your data into epochs and set the reference as
described above.
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Finally, after setting the reference, you can check for mistakes you may have made in labelling by

plotting the data. You can do this by clicking ‘In scalp/rect. array’ via ‘Plot’ and ‘Channel ERPs’ (IMAGE

5.66). A dialog opens similar to the one in IMAGE 5.67. Click ‘Ok’. Then, another dialog opens which

shows the average brainwave per channel. If everything went well, your channels should be located
in the same way as in IMAGE 5.68. From now on, you can do the rest of the analysis in the same way as

for the 40-channel data files.
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Topc-graphic ERP plot - pop_plottopo() [_ (O] x|
Channels to plot | 1:32
Plot title | ChildY epochs
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IMAGE 5.67
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IMAGE 5.68

Adding the channel locations manually is extremely time consuming, especially if there are more participants
that have been tested with the wrong configuration file. Therefore, it is a lot easier to epoch your 72-channel
data file with a script. You can either try to write your own script by clicking ‘New script’ in the MATLAB toolbar,
or you can contact_Ao Chen to ask for a standardised script. Don’t forget to adapt her script to your own
experiment!

5.3 Artefact reduction

After epoching your data files and saving them as .set files, it is time to remove the artefacts. If you
do this step right after epoching, you can continue working in the same dataset. Otherwise, you can
upload an epoched dataset by clicking ‘Load existing dataset’ via ‘File’ (IMAGE 5.69). Upload your
‘[ChildX]_epochs’ set.
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5.3.1 Plotyour data

Your first step in removing the artefacts from your data is to plot your dataset. You can do this by
going to ‘Plot’ in the toolbar, and click ‘In scalp/rect. array’ via ‘Channel ERPs’ (IMAGE 5.70).
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IMAGE 5.70

A dialog opens similar to the one in iIMAGe 5.71. Click ‘Ok’. Another dialog opens similar to the one in

IMAGE 5.72, which shows the average brainwave per channel.
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Topographic ERP plot - pop_plottopo() [_ O[]
Channels to plot | 1:32
Plot title | ChildX epochs
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Other plot options (see help) | vdir', 1
Help | Cancel | Ok |
IMAGE 5.71
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IMAGE 5.72

When looking at IMAGE 5.72, you will see that there is one wave (T7, circled in red) that looks quite
different from the rest. This usually means that this channel is quite noisy compared to the other
ones. Because this channel is so noisy, the y-axis of the scale circled in green is also extremely large.
Ideally, you'll want the y-axis to be as low as possible (based on our experience, the range between
-50 and +50 is usually good for further artefact reduction and averaging for infant data). Also,
remember that we are using the average of all electrodes as a reference, which means that one noisy
electrode affects the data of all other electrodes as well. This means that you'll have to interpolate
the channel T7, to reduce the noise from your dataset.

5.3.2 Interpolate noisy channels

To interpolate means to replace the data of one channel with the average of the data of the
surrounding channels. If you want to interpolate an electrode, click ‘Interpolate electrodes’ via
‘Tools' (IMAGE 5.74).
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After interpolating, plot your data again as
described above. Hopefully, you will now find that
all your channels look more similar to each other
(as in IMAGE 5.76), and that your y-axis (circled in green in IMAGE 5.76) is a lot smaller than before. If,
after interpolating, you find another electrode that looks very different from the rest, you can
consider interpolating that electrode as well.

IMAGE 5.75

NOTE: We strongly recommend to get good signal when you prepare the cap before starting the
experiment, rather than doing interpolation for many times offline. The less channels you have on
the cap, the more the data will be distorted by interpolation. Some researchers prefer to identify and
interpolate noisy channels visually by scrolling through the whole dataset, which is very time
consuming for large dataset. However, such a way may provide more detail about the dataset, which
may be desired for certain experiments. You need to figure out the best way for interpolation, and
whether you want to interpolate in the first place, yourself.
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5.3.3 Reject extreme values

After interpolating based on your plot, it is time to look more closely to the extreme values per
channel and trial. When removing artefacts based on extreme values, you get rid of the trials that
contain noise. MATLAB does this by looking for each trial if one of the electrodes exceeds a certain
artificial threshold. If so, it rejects the entire trial. This will clean up the noisy trials, and give you only
the clean ones which you can use for the rest of your analysis.

To remove the artefacts, go to ‘Reject data epochs’ via ‘Tools’ and click ‘Reject extreme values’ (IMAGE
5.77).
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IMAGE 5.78

A dialog opens similar to IMAGE 5.78. In the area circled in red, type in the numbers of the electrodes
you want to look at. If you need all your electrodes to be without noise for your further analysis,
select all electrodes (1:32). This will give you the cleanest data, but more rejected trials. If you only
want to look at a few electrodes, you can also decide to reject trials based on only the surrounding
electrodes. For instance, if you are mainly interested in the frontal electrodes, and you notice that in
a lot of children the posterior electrodes are very noisy, you can decide to base the rejection of trials
only on the frontal and central electrodes. This will probably give you fewer rejections. However,
your overall EEG data will be less clean.

Next, decide what you want to use as a minimum and maximum threshold (circled in green in IMAGE 5
.78). Per trial, MATLAB will look if there is an electrode that exceeds this threshold, and if there is, the
entire trial will be rejected. For our analysis, we will use +150 and -150 as our thresholds. You may
decide to do otherwise.

Tick the box circled in in IMAGE 5.78. This does not mean that the noisy trials will be removed
immediately, but it will give you the opportunity to remove them after scrolling through the rejected
trials. Then, click ‘Ok’.
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In IMAGE 5.79, you can see the data after looking for extreme values. In here, you find the signal of all
selected electrodes per trial. The trial number is indicated by the number circled in , and the
trials are separated by a dashed blue line. The red line indicates the onset of the stimulus, and the
red number circled in light blue indicates the stimulus type. In this image, you see that some trials
are shaded in green and some are white. The green ones indicate rejected trials. The red signals
within the green trials indicate the electrodes that exceeded the threshold in that particular trial,
which account for the rejection of that trial. Trial 58, for example, is rejected because both PO3 and
01 exceeded the threshold here. Which electrode belongs to which signal may be difficult to see
sometimes, but if you go to the signal line with your cursor, the label will appear in the area circled in
dark blue. You can scroll through the trials by clicking the arrows circled in red, or by typing a trial
number in the area circled in green. By scrolling through the dataset, you can find out if there is a
particular electrode that accounts for many rejected trials. For instance, if you see that PO3 and O1
are the cause for many of the rejections, you can consider interpolating these two channels as
described above. If you look at the rejected trials again after interpolating, you can see if it helped
you get more clean trials. If the difference is negligible, however, use the original data for those
electrodes.
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If you go back to your command window in MATLAB, you can see exactly how many trials are
rejected (circled in red in IMAGE 5.80). Ideally this number is as small as possible, but as children tend
to move a lot, there will always be rejected trials. Decide how many accepted trials are necessary for
your further analysis. Based on this, you can either decide to use a less strict rejection criterion (for
instance by rejecting trials based on only a part of the electrodes), or exclude the participant, if the
number of accepted trials is too low. NOTE: your rejection criterion has to be the same for all
participants!

If you are happy with the number of rejected trials, and no other electrodes need to be interpolated,
click ‘Reject’ (circled in purple in IMAGE 5.79). Save your new dataset as ‘[ChildX]_artfree.set’.

Unfortunately, this part cannot be done with help of a script, as you need to decide for each individual dataset
which electrode(s) you need to interpolate. This will be different for every dataset, and for every dataset the
criteria for interpolation may be different as well. Try to find a good balance between interpolating electrodes in
order to get less rejected trials, and preserving your original data as good as possible. This is may be difficult
sometimes and is usually primarily based on experience.
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5.4 Grand averages

5.4.1 Separate according to stimulus type

Next up is to extract the different stimulus types from your total dataset. In our research, we used 9
different types of stimuli, of which 3 were removed earlier when extracting the epochs. Therefore, 6
stimulus types still remain for our further analysis:

Event number | Stimulus type

2 Lexical tone: standard that follows another standard
3 Lexical tone: deviant

5 Music: standard that follows another standard

6 Music: deviant

14 Vowel: standard that follows another standard

15 Vowel: deviant

These six stimulus types are now still combined into one large dataset. To compare the ERPs for
different stimulus types, however, it is necessary to break the large dataset into smaller datasets
which contain only one single stimulus type.

To extract all epochs with the same stimulus type from the larger dataset, go to ‘Select epochs or
events’ via ‘Edit’ (IMAGE 5 .81).

FEGLAB v13.6.5b [_ O] x]
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IMAGE 5.81
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IMAGE 5.82
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A window pops up similar to IMAGE 5 .82. Select the event number you want to extract from the
dataset by clicking the button circled in red in IMAGE 5 .82 or by typing the event number in the blank
next to it. Click ‘Remove epochs not referenced by any selected event’ (circled in green in IMAGE 5 .82).
Click ‘Ok’. A warning pops up like in IMAGE 5 .83. Click ‘Ok’.

Confirmation H[=]

Warning: delete 771 (out of 1027) un-referenced epochs ?

Cancel | Ok |
IMAGE 5.83
EEGLAB v13.6.5b [ _ (O] x|
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IMAGE 5.84

Add something to your new dataset’s name to remind you of the stimulus type it contains. You will
see that the number of events has changed drastically: ours has changed from 1027 accepted epochs
to 256 epochs (circled in red in IMAGE 5 .84). This means that there are 256 accepted trials containing
the standard lexical tone (event number 2).

Repeat this step for all of your stimulus types. In our research, we will eventually end up with six
different datasets for each participant.

This step may take a long time when done manually. It can also quite easily be done with a script. Write your
own script, or contact Ao Chen if you want to make use of a standardised script. Note that you still have to
adapt her script to your own experiment!

5.4.2 Concatenate into grand averages

Once you have completed all steps described above for every participant, you will have a nice
overview of the amount of accepted trials per stimulus type per participant. Decide what the
minimum amount of accepted trials per person per condition should be, and in- or exclude your
participants based on this amount.

Once you have decided who to include and who to exclude, you can make a grand average file per

stimulus type. Go to ‘Grand average datasets’ via ‘Tools’ and click ‘Grand average datasets from files’
(IMAGE 5 .85).
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Next, select all included datasets from the same stimulus type (IMaGE 5 .86). Click ‘Open’. A new dialog
opens as in IMAGE 5.87. Name your grand average file as you wish, but make sure you remember
which data it contains. Also, save the new dataset as a file.
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IMAGE 5.87

A new dataset will open, in which you will see that the number of epochs is now the same as the
number of included participants (circled in red in IMAGE 5 .88). This is because in the previous step, the
average ERP was calculated for every participant, after which all averages were combined to make up
the grand average. Every participant therefore now represents one epoch. Repeat the same step for
all your stimulus types.
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IMAGE 5.88
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5.5 Plotting graphs

After converting your data into grand averages, you can have a first look at your results by plotting
two (or more) stimulus types against each other. In our research, we are interested in the difference
between ERPs following a standard and a deviant musical stimulus. Therefore, we have made a grand
average of all accepted ERPs following the standard stimulus, and one for all the accepted ERPs
following the deviant stimulus.

First of all, make sure you have loaded all the grand average datasets that you want to plot or

compare in EEGLAB. Next, click ‘Sum/Compare ERPs’ via ‘Plot’ in the toolbar (IMAGE 5.89). A window
opens, similar to IMAGE 5.90, in which you can define several options for your plot.
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In the areas circled in red in IMAGE 5 .90, insert the numbers of the datasets you want to compare
against each other. If you are not sure which number belongs to which dataset, you can go to
‘Datasets’ in the EEGLAB toolbar and look up the numbers (circled in red in IMaGE 5.91). The dataset
number is also indicated in the area circled in green in IMAGE 5.91.

In the area circled in green in IMAGE 5.90, indicate what kind of data you want to see in the plot. You
can choose to either see the average of both datasets plotted against each other, or plot the
difference between the two (or show all three waves together by ticking all three boxes). Other
possibilities are to plot the standard deviation (instead of the average), or plot all ERPs within one
dataset.

In the area circled in in IMAGE 5.90, indicate which channels you want to plot. If you don’t
insert anything here, all 32 channels will be visible in your plot. Because we are only interested in F3,
Fz and F4, we type the corresponding numbers here so that only these channels will be visible.

In the area circled in purple in IMAGE 5.90, you can insert a few things that will change the look of your
plot, such as direction and colour. By default, there will be ‘ydir’, -1 typed here. This means that your
y-axis will have positive values down and negative values up. By removing the minus sign (as seen in
IMAGE 5.90), your y-axis will be turned upside down, so that positive values are up and negative values
are down. Also, by default the colours of your two plotlines will be green and blue, which can be hard
to distinguish. By typing ‘colors’ {'k’ ‘r’} - or any other letters that resemble certain colours - the
colours will be changed, in this case to black (k) and red (r). There are more options to restyle your
plot. An overview of all of these options can be found in the ‘Help’ button (circled in blue in IMAGE
5.90). You can play with these options and see which look satisfies your needs.
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After you have clicked ‘Ok’, you can finally see the output of your research in a graph (IMAGE 5.92). If
you have selected only certain channels to display, these channels will be indicated by numbers in
the order you typed them in IMAGE 5.90 instead of their labels. You can click on one of these channels
to enlarge them and to see which colour represents which stimulus type (IMAGE 5.93).
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5.6 ERPLAB: Prepare your data

Once you have plotted your data, you finally have a first raw impression of your research outcome.
However, statistics are needed to conclude whether the differences between ERPs are significant. In
order to do statistics, you need to use the plugin ERPLAB.

5.6.1 Create binfile

First of all, open Notepad in Windows and create a .txt file in which you specify the different ‘bins’ in
your output. A ‘bin’ contains averaged ERP waveforms for every channel, which are based on a
certain type of data or event. State the bin number, the bin label and the event number as indicated
in the .set files. Use the format as shown in IMAGE 5.94. A more elaborate description of possible bin
formats can be found on the website of erplab.

|8 Bins_MMN - Notepad (_ O]
File Edit Format View Help
bini =l

tone standard
{23

binz2
tone deviant
REL

bin3
music standard
.15}

bing
music deviant
- 163

bin3s
vowe] standard
{14}

biné
vowe] deviant

{153

K Hl
IMAGE 5.94
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5.6.2 Convert artefact free files to ERPsets
In order to use ERPLAB, you first need to convert your datasets into .erp files. For the conversion, we

will use the artefact free datasets that you saved earlier. Open EEGLAB in MATLAB and load an
existing artefact free file. Next, go to ‘ERPLAB’, click ‘Utilities’ and then click ‘Convert an epoched

dataset into a continuous one’ (IMAGE 5.95). You will probably see a warning in yellow saying that you
are about to concatenate an epoched dataset. Click ‘Yes'.
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After creating a continuous dataset, you have to create an event list. Go to ‘Create EEG EVENTLIST’
via ‘ERPLAB’ and ‘Eventlist’ (IMAGE 5.96). You may see a yellow warning pop up which asks you to

change the labels of your events. Ignore this for now and click ‘Continue’.
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EJ ERPLAB 5.1.1.0 - CREATE BASIC EVENTLIST GUI

IMAGE 5.97

A pop-up opens, similar to IMAGE 5.97. Tick the boxes ‘Add code -99 for boundary events’ and ‘Create
numeric equivalents of nonnumeric event codes when possible’, as shown in IMAGE 5 .97. Click
‘Create’.

Next, you need to assign the bins to your new dataset. Go to ‘ERPLAB’ and click ‘Assign bins
(BINLISTER)’ (IMAGE 5.98).

EJ EEGLAB v13.6.5b

Study:

onin epoched data

IMAGE 5.98
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EN ERPLAB 5.1.1.0 - BINLISTER GUI

IMAGE 5.99

A window opens similar to IMAGE 5.99. In the area circled in red, load the .txt file in which you
specified your bins. The box ‘Current dataset’ (circled in green) should be ticked. Click ‘run’ (circled in
blue).

Now, you can epoch your data again. Go to ERPLAB in the EEGLAB toolbar and click ‘Extract bin-
based epochs’ (IMAGE 5.100). A new dialog opens, similar to IMAGE 5.101. Specify the time range (in
milliseconds) of your epochs (circled in red in IMAGE 5.101). Click ‘run’.

60



EEGLAB v13.6.5b =]
k|

File Edit Tools Plot Study

—#4: ChildX_|

Filename: none
Channels per 1
Frames per epc
Epochs

Events
Sampling rate
Epoch start (=
Epoch end (sec
Reference
Channel locati
ICA weights

Dataset size |

BABY EEG: PROTOCOL FOR TESTING AND ANALYSIS | BABYLAB UTRECHT

ERPLAB ERPsets Datasets Help
Artifact rejection in continuous data

Eventlist
Assign bins (BINLISTER)
EDF Visualizer

Transfer eventinfo to EEG.event (optional)
Extract bin-based epochs

EEG Channel operations

Filter & Frequency Tools

Artifact detection in epoched data

Summarize artifact detection

Compute averaged ERFs

ERP Operations

Plot ERP

Export & Import ERP

Load existing ERPset

Clear ERPset(s)

Save current ERPset

Save current ERPset as

Duplicate or rename current ERPset
Send ERPset by e-mail

IMAGE 5.100

ERP Measurement Tool
ERP Viewer

Average across ERPsets (Grand Average)

Utilities

Settings

Help

ERPLAB 5.1.1.0 - EXTRACT BINEPOCHS GUI

Bin-oased epoch fime range (ms)

s B3

Him

Bazseline Commeciion
£ Nome " Posl ™ custom (mz) stant stop
(+ P2 " Wk I
+ &
CANCEL ‘* RUN
IMAGE 5.101

Now, the last thing you have to do is to compute the averaged ERPs, which will finally turn your
dataset into an ERPset. Go to ‘ERPLAB’ in the toolbar and click ‘Compute averaged ERPs’ (IMAGE
5.102). A dialog similar to IMAGE 5.103 will pop up. Make sure the correct number of the to-be-
averaged dataset is written in the blank circled in green in IMAGE 5.103 (in this case, number ‘5’, as

seen in the title of the dialog in IMAGE 5.102). Also, tick the boxes ‘include ALL epochs (ignore artefact

detections)’ and ‘include standard error of the mean’ (both circled in red in iIMAGE 5.103). Click ‘run’.

61



BABY EEG: PROTOCOL FOR TESTING AND ANALYSIS | BABYLAB UTRECHT

EQ EEGLAB v13.6.5b

Study:

Al on in continuous data)

IMAGE 5.102

EJ ERPLAB 5.1.1.0 - WEIGHTED AVERAGER GUT

I
I~ | T ttion {reoommenea)

IMAGE 5.103

A dialog will pop up similar to IMAGE 5.104. This window allows you to name and save your new
ERPset. Click ‘create a new erpset’ (circled in red in IMAGE 5.104) and type in the name of your new
ERPset in the blank. Below, click ‘save ERP as’ (circled in green), click ‘browse’ and save your new
ERPset in your data folder. Click ‘Ok’. Your artefact free dataset is now converted into an .erp file.
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This step can easily be done with a script, which will save you a lot of time. Write your own script, or contact Ao
Chen if you want to make use of a standardised script. Note that you still have to adapt her script to your own
experiment!

5.6.3 Add difference waves to bins

As described earlier, our ERPsets now contain six bins: the standard and deviant stimuli of the lexical
tones, the standard and deviant stimuli of the musical melodies, and the standard and deviant stimuli
of the vowels. However, we are interested in the differences between the standards and deviants.
Therefore, we have to add another bin to the file which calculates the difference wave for every
modality. In our case, this means three extra bins: one for the lexical tones, one for the musical
melodies and one for the vowels.

To add new bins to your ERPset, go to ‘ERPLAB’ in the toolbar, go to ‘ERP operations’ and click ‘ERP
bin operations’ (IMAGE 5.105).
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A window opens similar to IMAGE 5.106. In the area circled in red, you will see a description of your
existing bins and their corresponding numbers. In the area circled in green, write down the equations
for your new bins, specifying the new bin number and the correct label for your new bin. In our case,
we write down the following:

bin7=bin1-bin2 label tone MMN
bin8=bin3-bin4 label music MMN
bin9=bin5-biné label vowel MMN

Click ‘run’. Be careful: after you've done this adaption, you won't be asked to save your new ERPset,
but the adaptation won’t be saved automatically either. Save your new ERPset by going to ‘ERPLAB’
in the EEGLAB toolbar and clicking 'Save current ERPset as’.

This step can easily be done with a script, which will save you a lot of time. Write your own script, or contact Ao_
Chen if you want to make use of a standardised script. Note that you still have to adapt her script to your own
experiment!

5.6.4 Compute ERP grand averages
Once you have converted all your datasets into ERPsets and added new bins for the difference

waves, you can compute the grand averages again. Go to ‘ERPLAB’ and click ‘Average across ERPsets
(Grand Average)’ (IMAGE 5.107).
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A window pops up similar to iIMAGe 5.108. Click ‘Add ERPset’ (circled in red), and select all the .erp files
that you created in the previous step. After you have clicked ‘open’, you will see the filenames
appear in the large white blank (circled in blue). This is your list of included participants. Click ‘Save
List as’ (circled in green) to save it as a .txt file and give your participant list a name. In future steps,
you can now easily upload your list by clicking ‘load list’ instead of selecting all participants again.
Finally, click ‘run’ (circled in ).
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In the next window that pops up, tick ‘create a new erpset’ and give it a suitable name. Also, tick
‘save ERP as’ (circled in red in iMAGE 5.109), click ‘browse’ and save your new .erp file in your analysis
folder. Click ‘Ok’. You have now created a grand average erpset.

With your new erpset, you can plot your difference waves again. Go to ‘Plot ERP’ in ‘ERPLAB’ and
click ‘Plot ERP waveforms’ (IMAGE 5.110).
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IMAGE 5.110

A dialog pops up similar to IMAGE 5.111. In the area circled in red, indicate the bins you want to plot.
Type the corresponding bin number to your difference wave in the large blank (in this example, we
are going to plot the difference wave for the vowel ERPs, which is bin number 9). In the area circled
in green, type the channels you want to plot. Indicate the channels in which you expect the highest
effect, and therefore want to use for your final analysis. Make sure the number circled in

matches the number of the erpset you want to plot. If you don’t know the number, you can look it up
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in the EEGLAB toolbar (IMAGE 5.112). You can also select a different erpset in the toolbar before you
start plotting.
When you've specified everything you need for your graph in IMAGE 5.111, click ‘Plot’ (circled in blue).
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IMAGE 5.112

The plots will finally be displayed as in iMaGe 5.113. When doing EEG experiments on adults, you will
probably find one clear negative peak somewhere around 150ms, but in infants, it is unknown where
to find the peak. As you see in IMAGE 5.113, the difference wave is mostly positive and stretches over a
long period of time. Therefore, the analysis will be slightly different, depending on the looks of your
plot.
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5.7 ERPLAB: Final analysis

The analysis from here afterwards is only suggestive for the sample dataset. Statistical analysis of
infant ERP data can be very tricky, search through literatures and think carefully how you want to
perform the statistical analysis. The following part may not be appropriate for your own dataset!

When doing the final analysis, there are two possible ways, depending on the looks of your
difference wave. If your plot shows a clear MMN peak, you can calculate the individual latencies and
amplitudes of the peak. However, infant data usually doesn’t show a clear peak, but rather a very
diffuse difference wave. In that case, you have to measure the differences in amplitude in sliding

windows.

5.7.1 My plot shows a clear MMN peak
Suppose you have plotted your difference wave in ERPLAB, and you find a clear peak in your plot (as
in IMAGE 5.114, indicated by the red arrow). This is your MMN peak, on which you want to do your

final analysis.
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5.7.1.1 Find the peak latency of the grand average

First, we need to calculate the latency of the MMN peak on the difference wave. Go to the ERP
measurement tool in ERPLAB (IMAGE 5.115)
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IMAGE 5.115

In the window that pops up, you can specify what kind of data you want. In the large blank on the left
hand side, load the grand average .erp file you created earlier to plot your data. You can do this by
clicking ‘add ERPset’ (circled in red in IMAGE 5.116). You may see a yellow warning pop up asking you if
you want to add this directory to your path. Click ‘yes’. Adding erpsets creates a new list. Click ‘save
list as’ (circled in green) to save it, otherwise it will not run.

Note: Now you have two lists: one includes all individual .erp files, and one contains only the grand
average .erp file. Be sure not to mix them up!

69



BABY EEG: PROTOCOL FOR TESTING AND ANALYSIS | BABYLAB UTRECHT

In the area circled in blue in IMAGE 5.116, you can state what you want to know about this list. In this
case, we want to know the peak latency of the difference wave, so we select ‘peak latency’. In the

area circled in , indicate whether you would like to know the latency of the most positive or
the most negative peak. As seen in IMAGE 5.114, we have a negative peak, so we select ‘negative’. In
the area circled in , indicate the bin number of the difference wave you are analysing. In this

dataset (which is actually an adult dataset), the bin number for the vowel difference wave is 15.
Below, state one channel on which you expect the difference wave. Because Fz is in between F3 and
F4, we choose to look at Fz (circled in purple). In the area circled in pink, indicate two latencies that
surround the MMN peak, so that the ERP measurement tool will find the most negative peak in
between these two latencies. Choose these latencies based on your plot. As you can see in IMAGE
5.114, our peak is somewhere between 200 and 300 ms, which is why we indicate ‘200 300’ in this
blank. Finally, indicate where and how you want to save the output in the area circled in brown in
IMAGE 5.116.

ENERPLAB 5.1.1.0 - ERP Measurements GUI - Peak latency = B
S Measurement
Typ2 l |Pex wency i =
(" Cumet ERPss
E=CRE e B ~] pes(20ms)
|=.s:'.‘s:s'ss negative values bacom e pose =1 Fieo= BT I vl =
= From ERPse Meny
im0 local peck ks found, use
) =1 |t 3 ramier ez =]
(% From ERPseties Cear All ERPaets |
Facor Mieasure's kel (optional)
1 |

Messurem ent winoow Easeline perio Preciskn
Pre -
I 200300 me B -]
(usetwo Iencles) I Foeomals

‘Save ouiput flle 35

| I DriUsers GE3TEESA0MMN_ULNIntntl lsanne'Protocol datbAANDrotco]_adul-peskyowek-tat xis I
J |cneEﬁpse|per line (wide format) | E—

-

I [~ | ase e mezsaremert wiaaw [ sendvalues o Workspace

P e
EanLe el :
Clear e isanel.lslaa i Remove ERPsst ELEL G =
viewsr

[ iciue bin iz0e 2 wel 25 b Ines

L2
L5

IMAGE 5.116

After you click ‘run’, your output will be saved as a .txt file as indicated in the area circled in brown in
IMAGE 5.116. Go to the folder in which you saved the output, and open the .txt file. If everything went
well, it will resemble IMAGE 5.117. In this file, you can see that the latency of the MMN peak is 252.009
milliseconds.
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5.7.1.2 Find the individual peak latencies

Now that we know the latency of the MMN peak in the grand average file, we can look for the
individual peak latencies. Because there is such a clear peak on the grand average difference wave,
we assume that the individual peaks must be somewhere around this latency as well. Open the ERP
measurement tool again, and edit the following things:

- Click ‘load list’ (circled in red in iMaGe 5.118) and select the list of the individual .erp files that you
created earlier when making your grand average file. You will see that all the individual erpsets
pop up in the large blank on the left hand side.

- Inthe areacircled in green, indicate the latencies +25ms around the grand average peak latency
(in our case, these are 227 and 277ms). We expect all peak latencies to be within this range. You
can also choose to use a different range, for instance £20ms.

- Inthe area circled in blue, choose a different name to save your new output file, otherwise the
old file will be overwritten.

Click ‘run’.
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In the new output file, you see that all data is written next to each other which makes it look
cluttered. Select and copy the entire content of the .txt file, minimize the analysis server window (as
it does not support Excel), and open up Excel on your own computer. Paste the data into Excel (IMAGE
5.119). Now, you can easily see each individual peak latency. You can see that every individual peak
latency lies within the two latencies we specified in the ERP measurement tool.
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When comparing different groups, make sure you compute a separate grand average file for each
individual group, and find the peak latencies per group. This could mean that you have different time
windows per group in which you search for the individual peak latencies. Finally, you can compare
the individual peak latencies by doing t-tests in SPSS, to see if there is a significant difference in
latency between the groups.

5.7.1.3 Find the individual peak amplitudes

Now, we're going to look at the amplitudes of the standard and deviant waveforms, as we want to
know whether these differ significantly. Open the ERP measurement tool again (IMAGE 5.120).

Edit the following:

- Inthe area circled in red (IMaGE 5.120), select ‘mean amplitude between two fixed latencies’.

- Inthe areacircled in green, indicate the bin numbers of the standard and deviant waveforms.

- Inthe areacircled in blue, indicate the channels that you're interested in again (in our case, F3,
Fz and F4).

- Inthe areacircled in , insert yet another name for your output file.

Click ‘run’.
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IMAGE 5.120

Copy your data from the .txt file again and paste it into Excel (IMAGE 5.121). You can now copy
everything to SPSS and run the rest of the analysis, by doing t-tests comparing ‘bin9_F3’ to

‘bin10_F3’, ‘bin9_Fz’ to ‘bin10_Fz’ and ‘bin9_F4’ to ‘bin10_F4’ (bin9 being the standard and bin10 the

deviant).
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5.7.2 My plot shows a diffuse difference wave

When testing infants, you are more likely to find a very diffuse difference wave, as shown in the plot
in IMAGE 5.82. When finding a plot like this, it is hard to decide where the peak is, even though a clear
difference wave is visible. Therefore, we will analyse the entire waveform using sliding windows.

5.7.2.1 Measure amplitudes in sliding windows

Because we cannot find a clear peak, we will skip the steps for finding the peak latency as described
in the example above. Instead, we will cut the waveform into small timeframes of 50ms (you can also
choose different timeframes, such as 100ms), and measure the mean amplitude of the standard and
deviant per timeframe.

Open the ERP measurement tool (IMAGE 5.115). A window will open up similar to IMAGE 5.122. Click
‘load list’ (circled in red), and load the participant list that you created earlier when computing your
grand average file. The list will show up in the large blank on the left hand side.

In the area circled in green, select ‘mean amplitude between two fixed latencies’, as you want to
know the mean amplitude of the standard and deviant wave per participant per timeframe. In the
area circled in blue, indicate the bin numbers for the standard and deviant. In the area below,
indicate the channels you want to analyse (we choose F3, Fz and F4; circled in ). Inthe area
circled in purple, indicate the timeframe of the first window. In our case, we'd like to analyse the
waveform between 100 and 600 in sliding windows of 50ms each, so our first timeframe will be 100-
150ms. In the area circled in , indicate where and how you want to save your output file. Make
sure to give this file a different name each time you analyse a new timeframe, otherwise the old file
will be overwritten. Click ‘run’.
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Your output file will be saved as a .txt file, in the folder indicated in the blank circled in in

IMAGE 5.122. When you open up this file, you will find that your data is all written next to each other,
instead of in columns (IMAGE 5.123). Therefore, you have to select and copy the entire content of

the .txt file, minimize the analysis server window (as it does not support Excel), open up Excel on
your own computer and paste the data into Excel. Now, you can easily see the mean amplitudes per
participant per channel for the first timeframe. Repeat these steps for every timeframe (150-200,
200-250, 250-300, and so on), and copy all data into Excel. Eventually, your Excel file will look similar
to the one in IMAGE 5.124.

,l. MMHprotocol_infant-window1 - Notepad
File Edit Format View Help
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Once you have all the data for all timeframes, you can compare the amplitudes for the standard and
deviant waves per channel and timeframe. This means you compare all amplitude values for the
standard stimulus on F3 in the first timeframe, with all amplitude values for the deviant stimulus on
F3 in the first timeframe (circled in red in IMAGE 5.124), and so on, by using t-tests in SPSS. This will
give you p-values for every channel and every window, so you can see exactly where the difference
between standard and deviant is significant, and whether the MMN is lateralised or not.

This final step will take a huge amount of time, so we recommend you to write a script for this. While writing a
script, you can immediately include the t-test analyses, so you will get a nice overview showing you the
outcomes of the t-tests per timeframe, channel and stimulus type (IMAGE 5 .125; description of the values is
written below). Try to write your own script, or contact Ao Chen if you want to make use of the script she wrote
for this experiment. Note that you still have to adapt her script to your own experiment, and that this script
requires more programming skills than the previous scripts!
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| resultt_mu | resultt_vowel
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5 20 0 -1.1133 0.2788 1 -2.3022 0.0322 0 -1.2125 0.2394
6 20 0 -1.4075 0.1746 1 -3.0089 0.0089 0 -1.3476 0.1929
7 20 0 -1.7961 0.0876 1 -2.8901 0.0091 0 -1.7006 0.1045
8 20 0 -1.9709 0.0627 1 -2.1421 0.0447 0 -1.6003 0.1252
9 0 0 -1.2862 0.2131 0 -1.5023 0.1486 0 -0.7897 0.4390
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13 20 0 0.6722 0.5092 0 0.6209 0.5417 0 0.1923 0.5494
4 20 0 0.4024 0.6916 0 -1.5431 0.1385 0 0.7956 0.4356 =
15
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IMAGE 5.125

Statistics of the comparison between the standard and the deviant stimulus for the vowel condition:
Column 1 =df

Column 2 = significance between std and dev on F3; 0 = not significant, 1 = significant
Column 3 = t-value for std-dev on F3

Column 4 = p-value for std-dev on F3

Column 5 = significance between std and dev on Fz

Column 6 = t-value for std-dev on Fz

Column 7 = p-value for std-dev on Fz

Column 8 = significance between std and dev on F4

Column 9 = t-value for std-dev on F4

Column 10 = p-value for std-dev on F4
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6. Appendixes

6.1 General testing checklist K.13

Preparation
In the control room:

Turn on computer EEG1 (Recording) and EEG2 (Presentation), and turn on all the screens.
Select an infant movie to play (if applicable). Set the video switch to the correct screen.

Turn on the Philips monitor.

Turn on the camera in the test room.

Turn on the Tangent amplifier (under the Philips monitor).

Set the audio switch to Tangent amplifier.

Before a baby is in the lab, run the experiment once to check whether sound and visual stimuli
work well.

In the test room:

Put the sound absorbing towel on top of the table

Put the toys on the table (if applicable)

Put gel into syringe

Get one baby EEG cap

Get the 32 Channel electrodes bundle

Turn on the air humidifier

Check the sound level using the audiometer. A loudness of 65 dB is recommended for the sound
stimuli.

Optional: prepare the cap in advance

Receive the parent and child

Welcome the parent and the baby in the waiting area. Take them to the lab

Put a little bit of gel on the baby’s wrist.

Explain to the parent what the experiment is about and what is expected of them/what they can
expect. Tell the parents:

e Don't let the baby pull the hat or the electrodes.

e Don't talk during the experiment.

e |f the baby gets fuzzy, you can stop at any time.

Check the baby’s wrist for allergic reactions. If absent, continue with the experiment.

Start the experiment
In the test room:

Clean the skin behind the baby’s ear with a cotton pad with alcohol.

Put EXG1 on the left mastoid and EXG2 on the right mastoid, connect these two electrodes to the
amplifier in the drawer.

Put on the cap.

Put gel into all electrodes.

Connect electrodes to the corresponding holes in the cap and to the amplifier.

Turn on the amplifier and check the blue light.

In the control room:

Click the BioSemi icon on desktop in the control room.
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- Click “start” on the BioSemi window, you should see all the electrodes now.

- Check impedance: go to tab “electrode offset”, set the scale on the left to 50mv, and all the blue
bars should be in the range +25mv.

- Setreference to Cz: go to the tab “monopolar display”. On the left of the screen, click “Free
choice” under “Reference”, and use the menu below to select Cz.

- Click “Start File” at the right bottom of the BioSemi window.

- Type in the participant’s information and save in your data folder.

- Click “pause save”, otherwise you are not recording!

- Open OBS Studio and click ‘Start recording’.

- On EEG2, open the experiment file, click run.

- Fill in the name of the participant in the pop up window “Enter Subject Name/ID”, in the same
format as in ActiView (EEG1).

- Use Enter key on the keyboard to start experiment. Use Esc if you want to abort the experiment.

- On EEG1, check whether triggers are sent. If not, call lab support.

After the experiment

- Ask if the parent wants to wash their baby’s head.
- Collect consent form from the parent.

- Give the baby the gift.

- Reimburse travel expenses.

- Ask for remaining questions.

Cleaning
- Clean the cap and electrodes

- Always use lukewarm water

- Never let electrodes sit under running water!

- Put away the toys and the cushion (if applicable)
- Fill in the experiment report
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6.2 Corresponding numbers to electrodes (32 channels)

Number Channel
1 Fp1
2 AF3
3 F7
4 F3
5 FC1
6 FC5
7 T7
8 C3
9 CP1
10 CP5
11 P7
12 P3
13 Pz
14 PO3
15 o1
16 0Oz
17 02
18 PO4
19 P4
20 P8
21 CPé6
22 CP2
23 c4
24 T8
25 FCé6
26 FC2
27 F4
28 F8
29 AF4
30 Fp2
31 Fz
32 Cz
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6.3 Channel locations (manual input)

# Label | Theta Radius | X Y z Sph_theta Sph_phi Sph_ Urchan
radius

1 Fpl -17.9260 0.5150 80.7840 26.1330 -4.0011 17.9260 -2.6980 85 1
2 AF3 -22.4610 0.4211 76.1528 31.4828 20.8468 22.4610 14.1970 85 2
3 F7 -53.9130 0.5281 49.8714 68.4233 -7.4895 53.9130 -5.0550 85 3
4 F3 -39.9470 0.3446 57.5511 48.2004 39.8697 39.9470 27.9730 85 4
5 FC1 -44.9250 0.1812 32.4362 32.3514 71.5981 44,9250 57.3870 85 5
6 FC5 -69.3320 0.4082 28.7628 76.2474 24.1669 69.3320 16.5180 85 [
7 T7 -90 0.5332 5.1765e-15 84.5385 -8.8451 90 -5.9730 85 7
8 C3 -90 0.2667 3.8681e-15 63.1713 56.8717 90 41.9960 85 8
9 CP1 -135.0750 0.1812 -32.4362 32.3514 71.5981 135.0750 57.3870 85 9
10 | CP5 -110.6680 0.4082 -28.7628 76.2474 24,1669 110.6680 16.5180 85 10
11 | P7 -126.0870 0.5281 -49.8714 68.4233 -7.4895 126.0870 -5.0550 85 11
12 | P3 -140.0530 0.3446 -57.5511 48.2004 39.8697 140.0530 27.9730 85 12
13 | Pz 180 0.2534 -60.7385 -7.4383e-15 59.4629 -180 44,3920 85 13
14 | PO3 -157.5390 0.4211 -76.1528 31.4828 20.8468 157.5390 14.1970 85 14
15 | 01 -162.0740 0.5150 -80.7840 26.1330 -4.0011 162.0740 -2.6980 85 15
16 | Oz 180 0.5067 -84.9812 -1.0407e-15 -1.7860 -180 -1.2040 85 16
17 | 02 162.0740 0.5150 -80.7840 -26.1330 -4.0011 -162.0740 -2.6980 85 17
18 | PO4 157.5390 0.4211 -76.1528 -31.4828 20.8468 -157.5390 14.1970 85 18
19 | P4 140.1030 0.3445 -57.5840 -48.1428 39.8920 -140.1030 27.9900 85 19
20 | P8 126.1330 0.5281 -49.9265 -68.3836 -7.4851 -126.1330 -5.0520 85 20
21 | CP6 110.6680 0.4082 -28.7628 -76.2474 24,1669 -110.6680 16.5180 85 21
22 | CP2 135.0750 0.1812 -32.4362 -32.3514 71.5981 -135.0750 57.3870 85 22
23 | C4 90 0.2667 3.8679e-15 -63.1673 56.8761 -90 42 85 23
24 | T8 90 0.5332 5.1765e-15 -84.5385 -8.8451 -90 -5.9730 85 24
25 | FC6 69.3320 0.4082 28.7628 -76.2474 24,1669 -69.3320 16.5180 85 25
26 | FC2 44,9250 0.1812 32.4362 -32.3514 71.5981 -44.9250 57.3870 85 26
27 | F4 39.8970 0.3445 57.5840 -48.1426 39.8920 -39.8970 27.9900 85 27
28 | F8 53.8670 0.5281 49.9265 -68.3836 -7.4851 -53.8670 -5.0520 85 28
29 | AF4 22.4610 0.4211 76.1528 -31.4828 20.8468 -22.4610 14.1970 85 29
30 | Fp2 17.9260 0.5150 80.7840 -26.1330 -4.0011 -17.9260 -2.6980 85 30
31 | Fz 0 0.2534 60.7385 0 59.4629 0 44,3920 85 31
32 | Cz 0 0 5.2047e-15 0 85 0 90 85 32
33 | EXG1 33
34 | EXG2 34
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